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Chapter 1: Getting Started 
Welcome 
Congratulations on purchasing a Pocket PC phone. The integrated wireless voice and data capabilities mean that as well as 
keeping your important PIM information up-to-date and close at hand, you can make calls, send and receive email, and look up 
valuable information from the Internet or your company’s network anytime, anywhere. Also, with Microsoft  ActiveSync , 
the power of your device is increased by allowing you to synchronize the information on your PC with your device. Picture 
yourself in the following situations: 
 
• While walking with a colleague, your Pocket PC device rings. You look at the caller ID and see it’s your manager who is 

calling. She asks if you two are free this afternoon for an emergency meeting. While your colleague fumbles through his 
paper organizer, you press a button on your device and instantly see a list of today’s appointments and meetings. You are 
quickly able to tell your manager your available times, and make a note of the new meeting while on the call. You hang up; 
send e-mail with a schedule request for the three of you at the desired location. 

• meeting your friends tonight for dinner and a movie. You download the latest movie information from the Internet to your 
PC and then synchronize it with your device. At dinner, you pull out your Pocket PC device and review your movie 
options with your friends. A Calendar reminder alerts you that it is time to catch the bus. You grab your Pocket PC device 
and catch the bus just in time. Because ActiveSync keeps the information on your device up-to-date, you leisurely review 
your task list, make notes about the new books and CDs you want to buy, and read and respond to e-mail messages. When 
you get back to the office, ActiveSync transfers any task changes you made, your notes, and your e-mail message 
responses to your PC. 

Where to Find Information 
This book describes your device hardware, provides an overview of the programs on your device, and explains how to connect 
your device to a PC, a network, or the Internet. For instructions on setting up your device, see the Quick Start Guide. The 
following table is a guide to additional information to help you use your device. 
 
For information on: See this source: 
Programs on your device This User’s Guide and device Help. To view Help, 

tap  and then Help. 
Additional programs that can be installed on the 
device 

The Pocket PC Companion CD. 

Connecting to and synchronizing with a PC  The Quick Start Guide or ActiveSync Help on your 
PC. To view Help, click Help and then Microsoft 
ActiveSync Help. 

Last-minute updates and detailed technical 
information 

The Read Me files, located in the Microsoft 
ActiveSync folder on the PC and on the Pocket PC 
Companion CD. 

Up-to-date information on your Pocket PC http://www.microsoft.com/mobile/pocketpc 
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Chapter 2: Hardware Features 
 
Your device has hardware buttons, and a stylus for selecting items and entering information. 

Front Panel Components 
 
 

 
 

1. 

2. 

1 Volume. Press to ad
2 Infrared port. Enab
3 Power Button. Pres

Backlight. Press and

4 Contacts. Press for 
5 Speaker. Listen to a
6 Notification LED: 

a) Flashing Green 
b) Flashing Green 
c) Steady Red – B
d) Flashing Red – 
e) Steady Amber –
f) Steady Green – 

7 Calendar. Press to q

8 End. Press to end a 
Phone On/off. Press

    
3. 
 

 

11.

12.

just the volume of your device.
les you to exchange file(s) or d
s to turn on/off your pocket PC
 hold to turn the back light on/

quick access to your Contacts. 
udio media or a phone call from

(Every 3 seconds) – GSM netw
(Every second) – Notification A
attery empty. 
Low battery. 
 Battery charging. 
Fully charged. 
uickly access the Calendar. 

call. 
 and hold to turn on/off your de
5. 
 

 

8.
9. 

7.
10
  
4. 
 
 
ata with other dev
 
off. 

 here. 

ork Signal. 
larm Reminder. 

vice’s phone.  

8

6.
ices without cables/ wires. 



9 Navigation Pad:  
Allows you to move up/ down and left/ right through any of the drop down menus or program instructions; select by 
pressing in the center. 
Left: When in the Dialer screen, press once to access the Speed Dial feature. 
Right: When in the Dialer screen, press once to access the Call Log feature. 

  
10 Microphone. Speak here when receiving/ making a phone call or voice recording. 

11 Send. Press to take an incoming call and to dial a number. 
Speakerphone. Press and hold for speakerphone mode.  

12 Touch Screen. For handwriting, drawing or to make a selection with the stylus. 

Back Panel Components 

 

3. 

4. 

5. 
1.

6.

2.

 
 
1. SIM card door. Open the rubber door to insert the SIM card. 
2. Antenna, stylus slot and stylus. The antenna has a neatly hidden slot for housing the stylus. 
3. To secure external battery. The optional external battery should be fastened here. (see the section, Attaching the 

External Battery)  
4. External battery connector cover. Remove this to uncover the connection between your device and the optional 

external battery. 
5. Main battery unit. The main battery is housed permanently inside the device – It should only be changed through an 

authorized sales center. 
6. External battery clip. Before screwing the extended battery into position please secure the clip on the bottom into this 

hole. 
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Bottom Edge Components 
 
 

 
1 Soft Reset. Press into the hole with the end of your stylus to reset your device. 

2 Sync connector. Use this connector when synchronizing/ transmitting data or recharging. 

3 Earphone Jack. Allows you to listen to audio media or use the phone hands-free kit. 

4 Battery on/ off switch. Press into the hole with the end of the top-half of your stylus to return the device to factory 
settings.  

 Battery off will wipe all the data from your device. 
5 MMC and SD card slot. Insert either MMC or SD cards in this slot. 

Accessories 

USB Cradle 

 

 

• Your Pocket PC Phone comes with a USB cradle. This allows you to 
recharge your Pocket PC Phone, as well as synchronize information 
between your Pocket PC and a PC using ActiveSync.  

 GPRS will not work when your device is plugged into the 
cradle. 

 To synchronize the USB Cradle must be plugged into an 
available USB port on your PC. 

 

 

 
 

1. 

5. 4. 

2. 

3. 
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Battery Life 
Your Pocket PC Phone contains a rechargeable Lithium polymer battery, which is housed permanently in your device. With 
continual use and recharging the battery will after a matter of years become unusable and should be changed through a service 
center. While you are using your device the amount of power consumed depends on whether you are talking on the phone, 
using the PDA functions or the device is on standby. The estimates for battery life – talk-time: 3~5 hours, PDA: 15-16 hours 
and standby:150 -170 hrs – are based on you only using this function so, as you will be continually interchanging between 
these features and functions the estimates will vary.  
   

  

YOUR POCKET PC CONTAINS A LITHIUM POLYMER BATTERY PACK. THERE IS A 
RISK OF FIRE AND BURNS IF THE BATTERY PACK IS HANDLED IMPROPERLY. 
DO NOT DISASSEMBLE, CRUSH, PUNCTURE, SHORT EXTERNAL CONTACTS, OR 
DISPOSE OF IN FIRE OR WATER. DO NOT ATTEMPT TO OPEN OR SERVICE THE 
BATTERY PACK. REPLACE ONLY WITH THE BATTERY PACK DESIGNATED FOR 
THIS PRODUCT. DISPOSE OF BATTERIES PROPERLY. 

 
Recharging the Battery 
Remembering to charge your battery is extremely important as your device does not have a hard drive - all your data and any 
new programs you install, are stored in RAM. In the event that the battery loses all its power the data and new programs 
mentioned above will be wiped off – only the default programs installed when you bought the device will remain. You can 
recharge your device in the following ways: 
 

 

 
• Place your Pocket PC Phone in the 

cradle and connect the cradle to an 
external power source. The first time 
you use it initially charge for three to 
four hours. Then, place it in the cradle 
for a short time each day to recharge it 
to its full capacity.  

   
AC Adapter plugs into the 
back of the cradle 
 11



 

 

• You can plug the AC adapter into the 
optional USB/Serial cable head and 
then connect your Pocket PC Phone 
directly to an external power source.  

 

 

                              

To your Pocket PC Phone                To AC adapter  

• You can plug the AC adapter into the 
optional DC Converter and then 
connect your Pocket PC Phone directly 
to an external power source. 

USB synchronization 
cable 

To your Pocket 
PC Phone 

Plug the AC adapter 
into a socket 

 

When Your Battery Is Low 
Your device has only one battery, however, a portion of that battery is saved as backup. If the battery gets very low, your 
Pocket PC Phone displays a warning message. If this occurs, save any unsaved data you are working on, perform a 
synchronization with your PC, then turn off your Pocket PC Phone. Don’t try to restart your Pocket PC Phone until you have 
connected to external power. If your Pocket PC Phone does shut down, the backup portion of your battery will protect your 
data for about 72 hours.  
 

Optional Accessories 
 
A) SD and MMC Cards 
Your device has an expansion slot compatible with a range of SD and MMC Memory cards, which are primarily used to 
backup or transfer files and data.  

To insert or remove a memory card: 
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1. Push the memory card into slot (see above) until it clicks 

into place. The card is secure when it is not protruding from 
the base. 

2. To remove the card push it in and then release, letting the 
card spring out. 

 

 When you receive your device there will be a piece of plastic in 
the slot; remove as described in “2” above. 

B) External Battery 
You can purchase an optional external battery to increase the battery life of your device by up to another 4 hours, and standby 
by another 150 hours - The external battery can be charged with either your device or with an External Battery Charger. 
Charging with the external battery charger should take about two and a half hours; when it is attached to the main unit total 
charging for the external battery and main unit should be about five hours. 
  

To attach the External Battery: 
 

 

 
 
 
1. Remove the rubber cover protecting the device connector 

for the external battery - The cap is situated just below the 
right screw on the back of the device. 

2. Hook the external battery into the embedded slot near the 
base of the back of your device (see picture to the left). 

3. Tighten the screws situated in the top of the external 
battery into your device.  

 

External Battery Screws

 

To view the current charge of the external battery: 
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When you attach the external battery an extra indicator will 
be added to the Power screen. 
 
To view this indicator tap Start, Settings, System and then 
Power. 

 

YOUR POCKET PC CONTAINS A LITHIUM POLYMER BATTERY PACK. THERE IS A 
RISK OF FIRE AND BURNS IF THE BATTERY PACK IS HANDLED IMPROPERLY. DO 
NOT DISASSEMBLE, CRUSH, PUNCTURE, SHORT EXTERNAL CONTACTS, OR 
DISPOSE OF IN FIRE OR WATER. DO NOT ATTEMPT TO OPEN OR SERVICE THE 
BATTERY PACK. REPLACE ONLY WITH THE BATTERY PACK DESIGNATED FOR 
THIS PRODUCT. DISPOSE OF BATTERIES PROPERLY. 

 
C) USB cable 

 
• The USB cable allows you to synchronize with your 

desktop without the cradle. The DC converter in the head 
also allows you, in combination with an AC adapter, to 
recharge your device.  
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D) DC Connector 
 

 
• The DC Connector in combination with the AC adapter 

allows you to recharge your device without the cradle. 

E) Serial Cable 

 

 
• The Serial cable allows you to synchronize with your 

desktop without the cradle. The DC converter in the head 
also allows you, in combination with and AC adapter, to 
recharge your device.  
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Chapter 3:Knowing Your Pocket PC Phone 
Reset the Pocket PC Phone and Clear Memory  
You can perform a soft reset or a full reset – a soft reset restarts your device and a full reset switches the battery off. The result 
of a soft reset is that some data may be lost in programs that are open, however, the result of cutting power is to wipe all the 
data and new programs you have added, and return the device to factory setting – i.e. it will only have the software that was 
present when you bought it. On this basis, it is important not to think about a full reset as you would restarting, shutting down 
or even switching off improperly your desktop, but rather like a complete crash requiring you having to wipe your OS. The 
importance of backing up data to a SD card or your computer cannot be stressed enough - in the event you have to perform a 
full reset your data will not be lost.   

To perform a soft reset: 
If your Pocket PC Phone responds slowly stops responding or freezes, try soft resetting it. A soft reset causes the Pocket PC 
Phone to restart and re-adjust memory allocation. Unsaved data in open windows may be lost. 
 
• Use the stylus to press and hold the Reset button. (For details on finding soft reset, see, “Chapter 2, Bottom Edge 

Features.”) 

To perform a full reset: 

 
A full device reset clears memory, deletes all data and restores the Pocket PC Phone to its default 
settings. Programs installed at the factory remain, while data you have created and programs you 
have installed are erased. 

   

1. Unscrew the stylus and use the smaller point of the 
top-half. 

 

 

 

 

2. Press the battery switch once to turn it off, and then once 
more to turn it back on. 
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Backing Up Files 
Because any new programs or data are stored in RAM, and therefore will be lost if you have to perform a full reset or your 
device loses all power for any other reason, it is absolutely paramount that you backup files to your computer, a memory card 
or FlashROM. When you are at your desktop you can synchronize with your computer to backup files, however, if you outside 
and unable to access your desktop, you will need to backup files to an SD or MMC card or FlashROM. In the former case, you 
can backup individual files in Word or Excel or all files in SD backup. In the latter case, through the program Permanent Save, 
it is possible to backup and then restore Contacts, Calendar, Internet and Email Settings. 

To save Word or Excel files to a memory card: 

 
 
 

 
 
1. In application programs (e.g. Pocket Word or Excel), press Tools, 

Options. 
 
2. Tap the drop down menu box under Save To and select Storage Card 

 

Backup or restore your system using SD Backup: 
  

1. Push the memory card into slot (see above) until it clicks into place. 
The card is secure when it is not protruding from the base. 

 

2. Tap , Programs, SD Backup then the Backup or Restore tab. 
 
3. If you have inserted the SD card properly it will appear next to 

Target. 
 
4. Make sure there are no application programs running in the 

background, then tap Start. 
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To backup to FlashROM: 

 

1. Tap , Settings, System and then Permanent Save. 
 
2. To backup Contacts or Calendar tap the PIM tab, and then check 

one or both of the boxes. 
 
3. To backup Inbox and Internet settings tap the Connections tab and 

then Backup to Flash. 
  

 
When you select to backup Contacts and Appointments, your 
device will automatically backup newly added contacts and 
appointments. This will not happen for connections: if you add 
another connection you will need to back it up manually. 
  

To restore from FlashROM: 
 

 

1. Tap , Settings, System and then Permanent Save. 
 
2. To restore Contacts or Calendar tap the PIM tab, and then check 

one or both of the boxes. 
 
3. To restore Inbox and Internet settings tap the Connections tab and 

then Restore from Flash. 
 

 

Screen tapping calibration and Re-calibration 
When you first startup your Pocket PC Phone, you will be asked to calibrate the screen by tapping the center of a cross with 
your stylus as it moves around the screen. This process ensures when you tap the screen with your stylus the item tapped is 
activated.  
If, however, when you are using your Pocket PC Phone, you discover tapping an item doesn’t bring up the appropriate response, 
it means your Pocket PC Phone has lost calibration. 
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To recalibrate the screen: 
 

 
 

 
• Tap Settings, System and then Screen. 

• As described above, tap the center of the cross to with your 
stylus as it moves around the screen.  

• Tap. Touch the screen once with the stylus to open items and 
select options. 

• Drag. Hold the stylus on the screen and drag across the screen 
to select text and images. Drag in a list to select multiple 
items. 

• Tap and hold. Tap and hold the stylus on an item to see a list 
of actions available for that item. On the pop up menu that 
appears, tap the action you want to perform. 

 

 
 

Today Screen 
When you turn on your device for the first time each day (or after 4 hours of inactivity), you’ll see the Today screen. You can 

also display it by tapping  and then Today. On the Today screen, you can see at glance important information for the day. 
  

 
Following are some of the status icons you may see. 
Status Icon Meaning 

 Turns all sounds on and off  

 Main battery low  

 Main battery very low  

 Connection is active  

 Synchronization is beginning or ending 

 Synchronization is occurring 

 Notification that one or more instant 
messages were received 

 Notification that one or more e-mail/ 
SMS messages were received 

 Shows the connection to your mobile 
phone service provider is on and the 
strength of the signal 

 
Indicates your phone is switched off. 
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If more notification icons need to be displayed than there is room to 

display them, the Notification icon, , will display. Tap the icon to 
view all notification icons. 

 

Programs 
You can switch from one program to another by selecting it from the  menu. (You can customize which programs you see 
on this menu. For information, see “Adjusting Settings,” later in this chapter.) To access some programs, you’ll need to tap 

, Programs, and then the program name. 
  
You can also switch to some programs by pressing a program button. Your device has one or more program buttons located on 
the front or side of the device. The icons on the buttons identify the programs they switch to.  
 

 Some programs have abbreviated labels for check boxes and drop down 
menus. To see the full spelling of an abbreviated label, tap and hold the 
stylus on the label. Drag the stylus off the label so that the command is 
not carried out.  

 
The following table contains a partial list of programs that are on your device. Look on the Pocket PC Companion CD for 
additional programs that you can install onto your device. 
 
 
Icon Program Description 

 
ActiveSync Synchronize information between your device and PC. 

 
Calendar Keep track of your appointments and create meeting requests. 

 
Contacts Keep track of your friends and colleagues. 

 
Inbox Send and receive e-mail/ SMS messages. 

 
Pocket Internet Explorer Browse Web and WAP sites, and download new programs and files from the 

Internet. 

 Notes Create handwritten or typed notes, drawings, and recordings. 

 Tasks Keep track of your tasks. 

 
Pocket Excel Create new workbooks or view and edit Excel workbooks  

 
MSN Messenger Send and receive instant messages with your MSN Messenger contacts. 

 
Pocket Word Create new documents or view and edit MS-Word documents. 

 
Phone Make and receive calls, swap between calls and set up conference calling.  

 
SD Backup Backup your Pocket PC Phone files to an SD card. 

 
SIM Manager Loads contents of your SIM card to your device and allow you to transfer to 

Contacts. 

 
Windows Media Player To enable the multimedia function on your Pocket PC Phone. 
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Navigation Bar and Command Bar 
 

 
 

 

 
• The navigation bar is located at the top of the screen. It 

displays the active program and current time, and allows 
you to switch to programs and close screens.  

• Use the command bar at the bottom of the screen to perform 
tasks in programs. The command bar includes menu names, 
buttons, and the Input Panel button. To create a new item in 
the current program, tap New. To see the name of a button, 
tap and hold the stylus on the button. Drag the stylus off the 
button so that the command is not carried out. 

Pop up Menus 
  

• With pop up menus, you can quickly choose an action 
for an item. For example, you can use the pop up menu 
in the contact list to quickly delete a contact, make a 
copy of a contact, or send an e-mail message to a 
contact. The actions in the pop up menus vary from 
program to program. To access a pop up menu, tap and 
hold the stylus on the item name that you want to 
perform the action on. When the menu appears, lift the 
stylus, and tap the action you want to perform. Or tap 
anywhere outside the menu to close the menu without 
performing an action. 
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Notifications 
Your device reminds you in a variety of ways when you have something to do or receive a SMS. For example, if you’ve set up 
an appointment in Calendar, a task with a due date in Tasks, or an alarm in Clock, you’ll be notified in any of the following 
ways: 
• A message box appears on the screen. 

• A sound, which you can specify, is played. 

• A light flashes on your device.  
• The device vibrates.  

To choose reminder types and sounds for your device, tap  and then Settings. In the Personal tab, tap Sounds & 
Notifications. The options you choose here apply throughout the device. 

Enter Information on Your Device 
You have several options for entering new information: 
 
• Use the input panel to enter typed text, either by using the soft keyboard or other input method. 

• Write directly on the screen. 

• Draw pictures on the screen. 
 
• Speak into your device microphone to record a message.  
 
• Use Microsoft  ActiveSync  to synchronize or copy information from your PC to your device. For more information on 

ActiveSync, see ActiveSync Help on your PC. 

Entering Text Using the Input Panel:  
  

• Use the input panel to enter information in any program on 
your device. You can either type using the soft keyboard or 
write using Letter Recognizer, Block Recognizer, or 
Transcriber. In either case, the characters appear as typed 
text on the screen.  

• To show or hide the input panel, tap the Input Panel button. 
Tap the arrow next to the Input Panel button to see your 
choices. 
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• When you use the input panel, your device anticipates the 

word you are typing or writing and displays it above the 
input panel. When you tap the displayed word, it is inserted 
into your text at the insertion point. The more you use your 
device, the more words it learns to anticipate. 

 

To type with the soft keyboard: 
 

  
 
 
  

 
 
  

 

1.   Tap the arrow next to the Input Panel button and then Keyboard. 

2. On the soft keyboard that is displayed, tap the key with your stylus 
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To use Letter Recognizer: 

 

 
With Letter Recognizer you can write letters using the stylus just as you would 
on paper. 
 
1. Tap the arrow next to the Input Panel button and then Letter Recognizer. 

2. Write a letter in the box. 

When you write a letter, it is converted to typed text that appears on the screen. 
For specific instructions on using Letter Recognizer, with Letter Recognizer open, 
tap the question mark next to the writing area. 
 

To use Block Recognizer: 
 
  

With Block Recognizer you can input character strokes using the stylus that are 
similar to those used on other devices. 
1. Tap the arrow next to the Input Panel button and then Block Recognizer. 

2. Write a letter in the box. 

When you write a letter, it is converted to typed text that appears on the screen. 
For specific instructions on using Block  
Recognizer, with Block Recognizer open, taps the question mark next to the 
writing area. 
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To switch to Transcriber: 
 
  

With Transcriber you can write anywhere on the screen using the stylus just as 
you would on paper. Unlike Letter Recognizer and Block Recognizer, you can 
write a sentence or more of information. Then, pause and let Transcriber change 
the written characters to typed characters. 
 
 

1. Tap the arrow next to the Input Panel button and then Transcriber. 

2. Write anywhere on the screen. 

For specific instructions on using Transcriber, with Transcriber open, tap the 
question mark in the lower right hand corner of the screen. 

 

To punctuate in Transcriber: 
 
  

 
1. Tap the keyboard on the toolbar. 

2. Tap OK to hide the keyboard. 
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To see how to write a letter in Transcriber: 
 
  

 
1. Tap “a” on the toolbar. 

2. In the screen that appears, select the letter you want to learn about, and then 
tap on one of the examples given above. 

For specific instructions on using Transcriber, with Transcriber open, tap the 
question mark in the lower right hand corner of the screen. 
 

Click on a letter for a demonstration 

To select typed text: 
 
  

If you want to edit or format typed text, you must select it first. To do so: 

• Drag the stylus across the text you want to select. You can cut, copy, and paste 
text by tapping and holding the selected words and then tapping an editing 
command on the pop up menu, or by tapping the command on the Edit menu 

 
. 

 
To change word suggestion options, such as the number of words suggested at one time, tap 

, Settings, Personal tab, Input, and then the Word Completion tab. 

To edit text: 
Each input program provides curser keys to move through text and backspace so that you can correct spelling, grammar or 
insert additional information. Alternatively, you can use your stylus to make an insert. 
After you have made an insert, you can use any of the input methods described above to add additional text at the insertion 
point. 
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Writing on the Screen 
In any program that accepts writing, such as the Notes program, and in the Notes tab in Calendar, Contacts, and Tasks, you can 
use your stylus to write directly on the screen. Write the way you do on paper. You can edit and format what you’ve written and 
convert the information to text at a later time. 

To write on the screen: 
  

• Tap the Pen button to switch to writing mode. This action displays lines on 
the screen to help you write. 

 

 Some programs that accept writing may not have the Pen button. See the documentation for 
that program to find out how to switch to writing mode. 

To select writing: 
  

If you want to edit or format writing, you must select it first. 
 
1. Tap and hold the stylus next to the text you want to select until the 

insertion point appears. 
 
2. Without lifting, drag the stylus across the text you want to select. 
 
If you accidentally write on the screen, tap Tools, then Undo and try again. You 
can also select text by tapping the Pen button to deselect it and then dragging the 
stylus across the screen. 
You can cut, copy, and paste written text in the same way you work with typed 
text: tap and hold the selected words and then tap an editing command on the 
pop up menu, or tap the command on the Edit menu. 
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To convert writing to text: 
 1. Tap Tools and then Recognize. 

 
2. If you want to convert only certain words, select them 

before tapping Recognize on the Tools menu (or tap and 
hold the selected words and then tap Recognize on the 
pop up menu). If a word is not recognized, it is left as 
writing. 

 
3. If the conversion is incorrect, you can select different 

words from a list of alternates or return to the original 
writing. To do so, tap and hold the incorrect word (tap 
one word at a time). On the pop up menu, tap Alternates. 
A menu with a list of alternate words appears. Tap the 
word you want to use, or tap the writing at the top of the 
menu to return to the original writing. 

 
 

Tips for getting good recognition: 
1. Write neatly. 

2. Write on the lines and draw descanters below the line. 
Write the cross of the “t” and apostrophes below the top 
line so that they are not confused with the word above. 
Write periods and commas above the line. 

3. For better recognition, try increasing the zoom level to 
300% using the Tools menu. 

4. Write the letters of a word closely and leave big gaps 
between words so that the device can easily tell where 
words begin and end. 

5. Hyphenated words, foreign words that use special 
characters such as accents, and some punctuation cannot 
be converted. 

6. If you add writing to a word to change it (such as 
changing a “3” to an “8”) after you attempt to recognize 
the word, the writing you add will not be included if you 
attempt to recognize the writing again.  
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Drawing on the Screen 
You can draw on the screen in the same way that you write on the screen. The difference between writing and drawing on the 
screen is how you select items and how they can be edited. For example, selected drawings can be resized, while writing 
cannot. 

To create a drawing: 
  

• Cross three ruled lines on your first stroke. A drawing box 
appears. Subsequent strokes in or touching the drawing box 
become part of the drawing. Drawings that do not cross 
three ruled lines will be treated as writing. 

 

To select a drawing: 
 
 
 
 
 
 
 
 
 
  

 
If you want to edit or format a drawing, you must select it first. 
 
• Tap and hold the stylus on the drawing until the selection 

handle appears. To select multiple drawings, deselect the 
Pen button and then drag to select the drawings you want. 

• You can cut, copy, and paste selected drawings by tapping 
and holding the selected drawing and then tapping an editing 
command on the pop up menu, or by tapping the command 
on the Edit menu. To resize a drawing, make sure the Pen 
button is not selected, and drag a selection handle. 

 

 You may want to change the zoom level so that you can more easily work 
on or view your drawing. Tap Tools and then a zoom level. 
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Recording a Message 
In any program where you can write or draw on the screen, you can also quickly capture thoughts, reminders, and phone 
numbers by recording a message. In Calendar, Tasks, and Contacts, you can include a recording in the Notes tab. In the Notes 
program, you can either create a stand-alone recording or include a recording in a written note. If you want to include the 
recording in a note, open the note first. In the Inbox program, you can add a recording to an e-mail message.  

To create a recording: 
  

1. Hold your device’s microphone near your mouth or other 
source of sound. 

2. Tap , and then Notes.  

3. Tap  to make your recording. Meanwhile a beep will 
in the beginning of the recording. 

4. Tap  to stop recording. Two beeps will sound. The 
new recording appears in the note list or as an embedded icon.

 You can also make a recording by tapping the Record button on the Recording toolbar. 

Using My Text: 
  

• When using Inbox or MSN Messenger, use My Text to 
quickly insert preset or frequently used messages into the 
text entry area. To insert a message, tap My Text and tap a 
message. 

• To edit a My Text message, in the Tools menu, tap Edit 
and then tap My Text Messages. Select the message you 
wish to edit and make desired changes. 

 

 You can add text after inserting a My Text message before sending it. 
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Find and Organize Information 
The Find feature on your device helps you quickly locate information.  

 
 • On the  menu, tap Find. Enter the text you want to find, select a 

data type, and then tap Go to start the search. 

 

To quickly find information that is taking up storage space on 
your device, select Larger than 64 KB in Type.  

 

 

 
• Tap in a file name, select a file type and press Go. 
 
• The name of the file will appear in the box entitled Results. 
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Managing Memory 
Memory on your Pocket PC Phone is shared between storage memory and program memory. Storage memory is used to store 
the information you create and programs you install. Program memory is used to run programs on your Pocket PC Phone. 
Pocket PC Phone automatically manages the allocation between storage and program memory.  

To view memory allocation and availability: 
 
Tap , Settings, System and then Memory. 
 
 
 
 
Finding Space in Storage memory 
However, in some situations, such as when memory is low, your Pocket PC Phone may not be able to automatically adjust the 
allocation. If you receive a message stating that storage or program memory is unavailable, try the following solutions. 

To make available storage memory: 
1. Move data to a SD storage card. 

2. Tap , Programs, and then File Explorer. Tap and hold the file you want to move, and tap Cut. Browse to the My 
Documents folder in the storage card folder, tap Edit, and then tap Paste. Files stored in folders other than My 
Documents or stored in folders within subfolders in My Documents may not show up in the list view of some programs. 
When using Notes, Pocket Word, or Pocket Excel, you can also move files by opening the item and tapping Tools or 
Edit and then Rename/Move. 

3. Move e-mail attachments. In Inbox, tap Tools and then Options. On the Storage tab, select Store attachments on 
storage card. All attachments are moved to the storage card, and new attachments are automatically stored on the storage 
card. 

4. Set programs such as Notes, Pocket Word, and Pocket Excel to automatically save new items on the storage card. In the 
program, tap Tools and then Options. 

5. If you are copying files from your PC or another device to your Pocket PC Phone, try adjusting the slider in the Memory 

setting. Tap  and then Settings. On the System tab, tap Memory and check whether the slider can be adjusted 
manually before copying files. 

6. Delete unnecessary files. Tap , Programs, and then File Explorer.  Tap and hold the file, and then tap Delete on the 

pop up menu. To find your largest files, tap  and then Find. In the Type list, tap Larger than 64 KB, and then tap 
Go. 

7. In Internet Explorer options, delete all files and clear history. In Internet Explorer, tap Tools and then Options. Tap Delete 
Files and Clear History. 
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Customize Your Pocket PC 
You can customize your device by adjusting device settings and installing additional software. 
 
Customizing the Today Screen 
You can customize the Today screen in the following ways: change the background picture, select the information you want 
displayed and in what order, and further customize to show future appointments. 

To change the background: 

 

1. Tap Start, Settings, Personal and then Today. 

2. On the Appearance tab, select the desired theme for the 
background. To use your own background, select Use 
this picture as the background and tap Browse to 
locate the desired file. 

3. Choose a folder and type and then tap find. 

4. Tap the picture you want to use and then tap OK. 

 
 
 
 
 
 
 
 

 

To customize the information you want displayed: 

1. Tap Start, Settings, Personal and then Today. 

2. On the Items tab: 

• Uncheck a box to remove its information. 

• Select an item and tap Move Up or Move Down to 
change its position. 

• Choose to select or deselect Display Today screen 
if device is not used for, and then select a number 
of hours from the box below. 

To customize Tasks or Calendar: 

1. Select Tasks or Calendar, and then Options to further 
customize.  

 

 

 
 

    33



Adjusting Settings 

You can adjust device settings to suit the way you work. To see available options, tap , Settings, then the Personal or 
System tab located at the bottom of the screen. 
 
• You might want to adjust the following: 
 
Icon Program Description 

 

Buttons To assign the application program to hardware button. 

 
Input To setup the input portion of your device. 

 
Menu To customize what appears on the  menu, and to enable a pop up menu 

from the New button. 

 
Owner Information To enter your contact information. 

 
Password To limit access to your device. 

 
Phone To setup the phone function of your wireless feature. 

 

Sound and notification To set the notification type, event, and volume. 

 
Today To customize the look and the information that is displayed on the Today 

screen. 

 
Backlight To customize the frontlight turns on/ off and brightness for power saving 

purpose. 

 
Clock To change the time or to set alarms. 

 

Microphone AGC To enable/ disable the microphone AGC. 

 

Power To maximize battery life. 

 
Regional settings To customize the region and relative format for the region you use. 

 
Remove programs You may through this function to remove some application program(s) not 

uses frequently to save the limited memory. 

 

Screen To re-calibrate the screen tapping and enable/ disable Clear Type feature. 
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Changing the Default Button Settings 
The buttons on your device are default set for Calendar, Contacts and Phone. The phone buttons cannot be changed, however, 
you can change the Calendar and Contacts buttons to open other programs. 

 

 

 

1. Tap Start, Settings, Personal and then Buttons. 
 
2. Select a button, a program in Button Assignment, and then tap OK. 
 

 

Adding or Removing Programs 
Programs added to your device at the factory are stored in ROM (read only memory). You cannot remove this software, and 
you’ll never accidentally lose ROM contents. ROM programs can be updated using special installation programs with a *.xip 
extension. All other programs and data files added to your device after factory installation is stored in RAM (random access 
memory).  
You can install any program created for your device, as long as your device has enough memory. The most popular place to 
find software for your device is on the Pocket PC Web site (http://www.microsoft.com/mobile/pocketpc). 

To add programs using ActiveSync: 
You’ll need to install the appropriate software for your device on your PC before installing it on your device. 
1. Determine your device and processor type so that you know which version of the software to install.  

Tap  and then Settings. On the System tab, tap About. In the Version tab, make a note of the information in 
Processor.  

2. Download the program to your PC (or insert the CD or disk that contains the program into your PC). You may see a single 
*.xip,  *.exe, or *.zip file, a Setup.exe file, or several versions of files for different device types and processors. Be sure 
to select the program designed for the Pocket PC and your device processor type. 

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions. 

4. Connect your device and PC. 

5. Double click the *.exe file. 

• If the file is an installer, the installation wizard will begin. Follow the directions on the screen. Once the software has 
been installed on your PC, the installer will automatically transfer the software to your device.  

• If the file is not an installer, you will see an error message stating that the program is valid but it is designed for a 
different type of PC. You will need to move this file to your device. If you cannot find any installation instructions 
for the program in the Read Me file or documentation, use ActiveSync Explore to copy the program file to the 
Program Files folder on your device. For more information on copying files using ActiveSync, see ActiveSync Help.  

Once installation is complete, tap , Programs, and then the program icon to switch to it. 
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To add a program directly from the Internet: 
1. Determine your device and processor type so that you know which version of the software to install.  

2. Tap  and then Settings. On the System tab, tap About. In the Version tab, make a note of the information in 
Processor.  

3. Download the program to your device straight from the Internet using Pocket Internet Explorer. You may see a single 
*.xip,  *.exe or *.zip file, a Setup.exe file, or several versions of files for different device types and processors. Be sure to 
select the program designed for the Pocket PC and your device processor type. 

4. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions. 

5. Tap the file, such as a *.xip or *.exe file. The installation wizard will begin. Follow the directions on the screen. 

To add a program to the Start menu: 
1. Tap , Settings, Menus, the Start Menu tab, and then the check box for the program. If you do not see the program 
listed, you can either use File Explorer on the device to move the program to the Start Menu folder, or use ActiveSync on the 
PC to create a shortcut to the program and place the shortcut in the Start Menu folder. 

2. Using File Explorer on the device: Tap , Programs, File Explorer, and locate the program (tap the folder list, 
labeled My Documents by default, and then My Device to see a list of all folders on the device). Tap and hold the program 
and tap Cut on the pop up menu. Open the Start Menu folder located in the Windows folder, tap and hold a blank area of the 
window, and tap Paste on the pop up menu.  

3. The program will now appear on the  menu. For more information on using File Explorer, see “Find and Organize 
Information,” earlier in this chapter. 

4. Using ActiveSync on the PC: Use the Explorer in ActiveSync to explore your device files and locate the program. Right 
click the program, and then click Create Shortcut. Move the shortcut to the Start Menu folder in the Windows folder. The 

shortcut now appears on the  menu. For more information, see ActiveSync Help. 

 

To remove programs: 

 

• Tap  and then Settings. 
On the System tab, tap 
Remove Programs. 

• If the program does not appear 
in the list of installed 
programs, use File Explorer 
on your device to locate the 
program, tap and hold the 
program, and then tap Delete 
on the pop up menu. 
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Chapter 4: Phone 
 

A) About Your Phone 
 
As well all the standard features of a mobile phone - such as mailbox and call log – there are several dialing features unique to 
your Pocket PC Phone. For example, you can take notes while talking, dial directly from Microsoft Contacts and easily transfer 
contacts between your SIM card and the RAM of your device.  
 
Additionally, like with a conventional mobile phone, you easily use one hand to access and navigate through the important 
features of your device and make calls.  
   
Installing The SIM 
♦ Remove the stylus. ♦ Turn over your device and open the 

SIM door with the stylus. 

 

 

 

♦ Slide the SIM card into the slot until it clicks 
into place. The SIM should be inserted 
exactly as the picture shows. 

 

 

 

Removing the SIM card 

 
MAKE SURE YOU HAVE SAVED ANY DATA IN OPEN PROGRAMS: OPENING THE 
SIM DOOR WILL TURN YOUR DEVICE OFF 

  

♦ Remove the stylus. ♦ Turn over your device and open the 
SIM door with the stylus. 

 

 

 

Press the point of your stylus into the hole until 
the SIM card springs out; then use your fingers 
to finish removing. 
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PLEASE PAY PARTICULAR ATTENTION TO 
THE STYLUS POSITIONS IN THE PICTURE 
ABOVE RELATED TO REMOVING THE SIM CARD, 
AND IN THE PICTURE TO THE RIGHT. DO NOT 
PUT THE STYLUS IN THE HOLE IN THE PICTURE 
TO THE RIGHT: IT WILL CAUSE IRREPARABLE 
DAMAGE TO YOUR DEVICE. 
 
SUCH DAMAGE IS CONSIDERED AS MISUSE AND 
WILL NOT BE COVERED BY WARRANTY 
SERVICE. 

 

 

About The Dialer Screen 

To access the Dialer Screen, tap  and then Phone, or press . From the dialer screen, as well as being able to make 
calls, access Call Log, Speed Dial and Phone Setting, you can find signal status information and important icons that tell you 
about your call. 

This icon indicates a call is being made and the strength of the signal. 

 
 

 
 
 
 
 
 
 
 
 

 
See all calls received, made and 
missed. 

 For numbers you call 

 
 
 
 
 
 

 

Keypad for inputting
Last number details are 
displayed here 
often 

Click Tools, Options to 
access phone setting. 
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The Navigation Pad and Dialing 
2.  

 
 

 

6. 

4

1. 

7. 

 

 

 

 

1. Take Call – Press to take an incoming call. 
Dialer Screen – Press to activate the dialer screen. 
Speakerphone – Press and hold to turn on or off the speakerphone during a call. 
Dial – Press to dial a number. 

2. Scroll Up – Press to scroll up through a list. 

3. End Call – Press to end a call. 
Phone Signal - Press and hold to turn on and off your phone. 

4. Call Log – After launching the dialer screen, press to enter the Call Log feature. 

5. Scroll Down – Press to scroll down through a list. 

6. Center – Press to select. 

7. Speed Dial – After launching the dialer screen, press to enter the Speed Dial feature. 

 

The icons listed below may be seen in the top bar of the screen: 

 - Phone off or out of network service, tap this icon to turn on the phone. 

 - In network service, tap this icon to turn off the phone. 

 - Call Missed, tap this icon to view the call(s) you missed. 

 - Unread E-mail or SMS, tap the icon to view unread SMS or E-mail. 

 - Connecting in progress, the icon will disappear when you are connected to your ISP. 

   - Shows your connection is at full strength. 
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Entering Your PIN 
Most SIM cards are preset with a PIN (Personal Identity Number), provided by your mobile service provider, which you 
need to enter whenever you use your device.  

 

 
1. Enter the preset PIN from your mobile phone service provider (please 

contact your mobile service provider).  

2. Tap        . 

3. If your PIN is entered incorrectly three times, then SIM card will be blocked. 
If it happens, you can unblock it with the PIN Unblocking Key from your 
mobile phone service provider.  

 
Checking You Are Connected 
The default settings for your device are programmed to assume you want to use your phone so, providing you have inserted a 
SIM card, your device will turn on your mobile phone connection to your service provider’s network. 
  
The icon  indicates that you are connected to the network of your mobile phone operator – Thereafter a full strength signal is 

indicated by  and as the strength of the signal diminishes so will the number of vertical bars in the icon, with no bars 
indicating no signal.   
 
 

 If you have turned the phone off, removed and then reinserted the SIM card, your device will 
not automatically turn the phone on. In this event, turn it on as described below in Turning the 
Phone Connection On and Off. 

 
Turning The Phone On and Off 
As indicated above your Pocket PC will turn on your phone when you insert a SIM card, however, you can choose to turn off 
your phone and just use the Pocket PC features at anytime – and then turn it back on when you want.  
 

 
 

IN MANY COUNTRIES YOU ARE REQUIRED BY LAW TO TURN OFF YOUR 
PHONE WHEN YOU FLY. TURNING OFF YOUR POCKET PC DOESN’T TURN OFF 
YOUR PHONE; YOU MUST TURN OFF YOUR WIRELESS CONNECTION TO 
YOUR OPERATOR’S NETWORK.  

To turn off the phone: 

Press and hold the button until  appears in the navigation bar. Or, tap  and then Turn phone off from the pop-up 
menu. 
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To turn on the phone: 
Press and hold  until  appears in the top toolbar. 
 
Adjusting The Phone Volume 

 

 
1. You can tap icon    or press the volume on the side bar of your device 

during a call.  

 To adjust the conversation phone volume, you must do it during a 
call. If you adjust the volume at another time it will affect the ring and 
notification levels, and MP3. 

 
Back Spacing and Deleting  
If you tap a wrong number when you are keying in, you can back space to erase individual numbers one at a time or you can 
delete all the numbers in the window. 

To back space over numbers: 

 

Tap here to back space and 
erase numbers individually. 
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To delete the number: 

 

Tapping Clear will 
erase 098-57 as will 
holding down the 
backspace key. 

Saving Personal Numbers 
You can choose to save your personal phone numbers in a separate screen in SIM Manager. 

To save personal numbers: 
1. Tap Start, Programs, SIM Manager, Tools and then Personal Numbers. 

2. Add a number to the screen and then tap OK. 
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B) Basic Dialing Features 
In this section you can find information on the basic features of your phone: making or answering a call, using the 
speakerphone, making notes during a call, putting a call on hold, and using the conferencing facility. You can also send SMS 
from the Dialer screen. 
 
Making a call 
With your Pocket PC Phone, you can make a call from the Dialer, Speed Dial, Call Log, Contacts and SIM Manager. 

To make a call from the Dialer: 
1. Press to bring up the dialer screen. 

2. Tap the number into the keypad and then tap  or press  button. 
 
 
 

 
 

 

 

 

 

 

 

 

 

 

To make a call from Contacts: 

 

 
You can make a call from Contacts in the following way: 
 

1. Press the Microsoft Contacts Button, find the contact and then tap  twice – 
once to send to the dialer screen and once to call. 

 

 The pop up menu and  button will by default display Call Work 
Tel.  However, you can customize so that the mobile number or email is 
displayed instead: 

Tap the number you wish 
to dial here. 

The signal icon will change when you 
are making a call.  

The number will appear 
here. 
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Either: 
 
1. Select a contact in the contacts list and then press left or right on the navigation 

pad – the number on the screen will change. 
 
Or: 
 
1. In the contacts list tap the “w” in the right column next to the contact you want 

to customize. A pop-up menu will display the phone numbers and email 
addresses for this contact with a dot next to the priority number. 

 
2. In the pop-up menu select a priority – If you selected mobile number, “m” 

should now be in the right column next to the contact. 

To make a call from Speed Dial (A): 
 Speed dial is a list you can create of often-dialed numbers. Information on adding a 

number to Speed Dial is detailed later in this chapter. 
 
By memorizing the position in the Speed Dial list of a number, you can dial the 
number by entering its position number. For example: 

 
In the picture on the left John Fredericks is at position 4. To dial his number 
simply tap and hold 4 on the dialer keypad; if the number holds a position of 
10 or more tap the first number, and then tap and hold the second to dial. 
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To make a call from Speed Dial (B): 
 Alternatively, if you don’t remember the position of a number in the Speed Dial 

list use the method below: 
 
1. Go to Phone, press once the left-side of navigation pad, or tap . 
 
2. In Speed Dial use the navigation pad to find the number you want to dial, and 

then press . 
 

 

To make a call from the Call Log: 
  

1. Go to Phone and press the right side of the navigation pad or tap  
 
2. Find the call details by first selecting the category it is filed under. For 

example, if it is in All calls select All calls from the drop down menu in the 
top-left corner. 

3. Use the navigation pad to find the number and then tap  or the icon to 
the left of the number you wish to call. 

 

Icon  is for incoming calls; icon  is for outgoing 

calls and icon  is for missed calls.  
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To make a call from SIM Manager: 

 

 

1. Tap , Programs, and then tap SIM Manager – 
wait for your SIM card contents to load. 

 
2. Tap and hold the name or phone number of the person 

you wish to call, and then select Call from the pop-up 
menu. 

 

To send SMS in phone dialer: 
 

 

1. Tap Tools, and then Send SMS.  

2. The screen below will appear. 

3. Tap New.  

4. In the To field, enter either e-mail address or SMS 
number of one or more recipients, separating them with 
a semicolon, or select a name from the contact list by 
tapping the Address Book button. All e-mail addresses 
entered in the e-mail fields in Contacts appear in the 
Address Book. 

5. Compose your message. To enter preset or frequently 
used messages, tap My Text and select a message. 

6. Tap Send when you’ve finished the message. If you are 
working offline, the message is moved to the Outbox 
folder and will be sent the next time you connect. 
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1. Whether you want to send or read E-mail or a SMS, 

you can swap by tapping Services then choose what 
service you want. 

2. If you are sending an SMS message and want to know if 
it was received, tap Edit, Options, and select Request 
SMS text message delivery notification before 
sending the message. 

 

 
Enabling the Speakerphone Mode 
Your device has a speakerphone allowing you to talk hands-free and/or let other people to listen to the caller. 
 

  
 
1. Wait until the phone is ringing. 
 

2. Hold down the  until the speakerphone comes on 

and the icon  appears in the top toolbar. 
 

3. To turn off the speakerphone hold down the again. 
 
 

 Do not leave the phone in speakerphone 
mode and hold it on your ear; the sound will 
damage your ear. 
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Answering or Rejecting a Call 
  

 

• Tap Answer, or press  on your device. 
 

• Tap Ignore or press  to reject the call. 
 

 If you reject a call the busy tone will be sent out. 

 
Ending a Call 
  

• Once an incoming or outgoing call is proceeding, you can press  or tap 
 to end the call.  

 
Managing More Than One Call 
Your device will notify you when you have another caller and you have the choice of rejecting or accepting incoming call. If 
you accept you can then choose to swap between this caller and the original or set up a conference call between all 3 parties. 
You can, of course, also initiate the situation above – with conference calling you can create a conversation between up to 6 
people.  
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Putting a Call on hold: 
 

1.  
 
1. If another person is trying to call you when you are talking on the phone the 

screen to the left will pop out. 
 
2. Tap Answer to the take the 2nd call and put the 1st on hold. 
 

3. To end the 2nd call and go back to the 1st, tap End or . 

To swap between calls: 
 

  
 
 
 
 
 
 
 
  

 
• You can choose to swap backwards and forwards between 

2 callers by pressing Swap. 
 

To change to 
the other 
caller tap here 

Indicates which 
number is on 
hold  
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To set up conference calling: 
 
  

1. Either put a call on hold, dial a 2nd number and wait for it to be picked up. Or, 
accept a 2nd incoming call when you already have one in progress. 

2. In the screen that appears tap Conference. 

 3. If the conference connection is successful the word Conference will appear at the 
top of the phone dialer screen (as left). 

4. To add additional people to your conference call tap Hold, key in the number, and 
then Resume to return and continue.  
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Making a Note 
Regardless of whether you call from the Dialer, Contacts, Call Log,, Speed Dial or SIM Manager, you can take a note 
during a call. After you have finished the note it will be saved as an attachment to your call in one of the Call Log folders. 

To make a note: 
 1. After you have entered a number and tapped  or , tap the  

icon situated at the bottom of the screen.  
 
2. Use any of the input methods to record your note and then tap OK. - You can 

finish your note during or after the call. 

To view a note: 
  

1. Press the right side of the navigation pad or tap , tap and hold the call, 
and then from the pop up menu tap view note. (The icon indicates a note). 

 
2. Or, go to Notes, and then tap the name of the file from the list. (For more 

information, see “Chapter 4, Notes”)  

 you decide to create a contact for this caller – see Adding and 
Transferring Contacts information” – the call and file names will be 
amended to the name of the new contact; the file will be unaffected.  
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C) Call Related Features 
Checking Your Voice Mail 
  

• The first speed dial location defaults as your voice mailbox. When you insert 
your SIM card into your Pocket PC Phone, it will automatically detect and set 
as default the voice mailbox number of your mobile service provider. 

To retrieve your voice mail: 
• Press , the left side of the navigation pad, select  Voice Mail and then 

press . 
 
 
 

 
Adding and Transferring Contact Information 
As there is a number of ways in which telephone numbers and contacts can enter and then be stored on your device and a 
number of ways to make a phone call, it is important to be able transfer those contacts between the programs used to make a 
call. 

Places where contacts can enter your device and be stored: 
♦ Your SIM card - You interchange your SIM card between your Pocket PC Phone and another device; while using the other 

device you create one or more new contacts on the SIM card. 
 
♦ Microsoft Contacts. 
 
♦ Call Log – New contact numbers can be found in incoming or missed calls. 

 Why transfer numbers? 
♦ In the event you lose your SIM card while using it with another device your SIM numbers will be backed up to your 

device. 
 
♦ If you want to transfer a number to Speed Dial it must be in Contacts, not on the SIM card. 
 
♦ If you are using your SIM with another device, you may need the numbers stored in Microsoft Contacts. 
 
♦ Transferring numbers to Microsoft Contacts allows you to create a more detailed record. 
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Microsoft Contacts: Adding and transferring contacts  

 

 

1. To create a contact, see creating a contact in Chapter 4.  

2. To transfer a contact to SIM, press and hold the center of the navigation pad - 
or tap and hold the contact - and then select Save to SIM from the pop up 
menu. 

3. To transfer a contact to Speed Dial, press and hold the center of the navigation 
pad – or tap and hold the contact - and then select Add Speed Dial Work Tel 
from the pop up menu.  

4. In the next screen add the contact details, select a location and tap OK.  

 
By default the Location function will give tell you the next 
available position in the Speed Dial list. If you want to put a 
number in a position that is already occupied, the new number will 
replace that number already there. 

 

SIM Manager: Adding and transferring contacts  

To create a SIM contact: 

 

 
1. Tap SIM Manager (wait for SIM contents to load), then New. 
 
2. Fill in the Name and Phone details and tap Add. 
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To transfer contacts from SIM to Microsoft Contacts: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1. Tap SIM Manager (wait for SIM contents to load), then 

Either: 
 
Tap Tools, Select All, and then Save to Contacts. 
 
 
 
 
 
 
 
 
 
 

 Or:  
 

Press and hold the center of the navigation pad – or tap and hold a contact from 
the list - and then select Save to Contacts from the pop up menu. 

To transfer a number to Speed Dial: 
 

 

 

 

1. Press , either the left side of the navigation pad or Speed Dial, and then 
New. 

2. Find the contact you want to add, and then press the navigation pad center.  

3. When the contact name and number appears in the screen – as left - select an 
available location using the arrow keys.  

 

 By default the Location function will give you the next available position 
in the Speed Dial list. If you want to put a number in a position that is already 
occupied, the new number will replace that number already there. 
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To add a record to Microsoft Contacts from Call Log: 
  

1. Press , and then the right side of the navigation pad. 
2. Find the call details by first selecting the category it is filed under. For 

example, if it is a missed call select Missed from the drop down menu in the 
top-left corner. 

3. Press and hold the navigation pad center; in the pop-up menu that appears 
select New Contact.  

4. In the New Contact screen add additional contact details and press the 
navigation pad center or tap OK. 

5. The call details in the Call Log will then be amended and displayed under 
the name of the contact, not telephone number. 

 

Managing Your Call Log 

The Call Log details all incoming, outgoing, and missed calls and also provides a summary of total calls. The Call Log can 
also tell you when a call was initiated, how long it lasted, and provides easy access to any notes taken during the call. 

Tap here to select All 
Calls, Missed, Outgoing, 
Incoming or By Caller  

Viewing detai
Tap in the top left corn

Calls are categorized a

 

• All Calls - shows 

•   Missed - 

    
Name
 
Number
 

ls of calls 
er of the screen and then select a category from the drop down m

s below: 

all calls made to and from the phone in chronological order.  

only shows calls that were not answered.  

55
Time of call
enu.  



•   Outgoing - only shows calls made from the phone.  

•   Incoming - only shows calls made to the phone.  

• By Caller - categorizes calls alphabetically according to caller.  

To view duration of call: 

 

• Go to Call Log, find the call you are interested in, and then tap it once. 

To delete Individual calls from Call Log: 
• Press and hold the center of the navigation pad, and then select delete from the pop up menu. 

To delete all calls from Call Log: 
• Tap Tools, and then Delete all Calls. 

To set limits on the size of your Call Log: 
  

• Tap Call Log, Tools, Options and then the box under Delete call log items 
older than. 

• In the drop down menu choose a period of time and then tap OK. 
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D) Customizing Your Phone 
 
You can personalize the setting of your phone, the services you have and the network you are connected to. 

To select ring type and tone, and Keypad sounds: 
 1. In phone dialer, tap Tools, Options and then Phone.  

2. Tap to see the drop-down menu choices below. 
 

                     
 
  
 
 

Ring type   Ring tone   Keypad 

 

Downloading Ring Tones 
You can make a connection to the Internet and then download ring tones that are compatible with the .WAV format. 

Managing Ring Tones 
Add Ring Tone allows you to quickly find and display all the ring tones stored on your device, gives you the option to listen, 
and then add or remove them from the Phone Settings list mentioned above. 

To display all ring tones on your device: 

 

Tap , Settings, System and then Add Ring Tone – the program will 
automatically list and display all the .wav files on your device. 
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To play a ring tone: 

 

• After the ring tones have loaded, select one by tapping it, and then tap play. If 
you don’t like the ring tone deselect it. 

 

To add a ring tone to phone settings: 

 

1. When the ring tones have loaded, you will see that some are already selected; 
these ones are presently listed in phone settings. 

 
2. Tap the name of any ring tone then to add or remove from the list in phone 

settings. 
 

 

To enable the PIN: 
1. In phone dialer, tap Tools, Options and then Phone.  

 
2. Under Security, tap the option Require PIN when phone is used. 
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To change the PIN: 

 

1. Under Security, tap Change PIN. 
 
2. Follow the instructions - enter the old pin, then a new one, and reenter for 

confirmation.  

To enable Caller ID: 
 When you place a call, your phone number will be revealed to the person that you are 

calling. To enable or disable this function: 

1. 

2. 

In phone dialer, tap Tools, Options and then Services.  

In Services, tap Caller ID, and then Get Settings (retrieving settings may take a 
few minutes). 
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3. In the next screen, tick either Everyone I call (Enable) or Never provide caller 
ID (Disable) and then OK.  

 

Call forwarding  
This service allows you to forward your incoming calls to another phone number. You can choose to forward all calls to the 
same number or specify a number based on the following conditions:  

Unavailable: If your phone is turned off or your phone is out of the network service. 
Busy: When you are on the phone. 
No answer: If you do not answer your phone.   

To activate or deactivate call forwarding: 
 

 

 

1. In phone dialer, tap Tools, Options and then Services.   

2. In Services, tap Call Forwarding and then Get Settings (retrieving settings 
may take a few minutes). 

3. In Call forwarding either tick Forward all incoming phone calls and then 
enter a number in the box below – or, according to circumstance, select one or 
all of the other categories and enter numbers. 
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Call waiting  
This service allows you to receive another call during an active call. You can also turn this option off by selecting Do not 
notify me.  

To activate or deactivate call waiting: 
 1. In phone dialer, tap Tools, Options and then Services. 

2. In Services, tap Call waiting and then Get Settings (retrieving settings may 
take a few minutes). 

3. Then in Call waiting select Notify me or Do not notify me and tap OK.  

 

Voice mail and SMS  
By default your device will automatically detect and set your voice mail and SMS access numbers. However, you can view the 
settings if you want.  

To view your voice and SMS access numbers: 
  

1. In phone dialer, tap Tools, Options and then Services. 

2. In Services, Voice mail and SMS, and then Get Settings (retrieving settings 
may take a few minutes). 

3. Then in Voice mail and SMS type in the access numbers and tap OK.  
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To find a network: 
 

 

1. In phone dialer, tap Tools, 
Options and then Network. 

2. Tap Find Network 
(retrieving settings may take a 
few minutes). 

 
 
 
 
 
 
 
 
 
 
 
 

 

 
You can enable this function when the network status is currently out of network service and you 
want to conduct a search 

 

To select a Network: 
 1. In phone dialer, tap Tools, Options and then Network. 

2. Select either Automatic or Manual in Network selection (retrieving settings 
may take a few minutes when you select Manual). 
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To set preferred networks: 
 1. 

2. 

3. 

In phone dialer, tap Tools, Options and then Network. 

To select Set Preferred Networks (retrieving settings may take a few minutes).
 

To select either networks and re-prioritize the order for network usage. 
 
 

 If there are many mobile phone service providers available to you, enable 
this function to select a lower fee network  

 

To select automatic Pickup: 
This feature, which instructs your phone to pick up the call automatically, is particularly helpful when you are in a hands-free 
environment. For example, if you are driving and using the earphone, the call will be picked up after a designated number of 
rings and your hands never have to leave the wheel. 
 

 

1. 

2. 

In phone dialer, tap Tools, Options and then More. 

To enable either On then set the rings without pressing Talk will automatic 
answer or Off. 
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Using Key Lock  
Key Lock enables you to lock the buttons on your device so that only the On/Off button will turn your device on. Locking 
your device in this way ensures you can’t switch the device on by accident, and consume unnecessary power. 
 

 Enabling Key Lock when you are using your phone features will slow down your ability to answer 
a call. 
 

To enable Key Lock: 
1. Tap Phone, Tools, Options, and then More. 
 
2. Under Hardware Key Lock, select Lock all buttons except power button, and then OK. 
 

Enabling Broadcast Channels 
You can choose to receive real-time news and information, such as traffic news and weather reports. 

To enable Broadcast Channels: 

 
 

 

1. Tap Phone, Tools, Options, and then More. 
 

2. Under Broadcast Channels tick Enable, and then tap Settings. 
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3. Tap Receive Channel list – the list will appear in your Inbox. 
 
4. After retrieving the list and deciding which channels you want, return to this 

page and tap New. 
 
5. In the next screen, enter a channel name and number, and tap OK – the 

channel name will appear in the box under Select Items to Receive. 
 
6. Tick the box next to the channel name to select it. 
 
7. Repeat the process for all channels you want to add. 

 

E) Additional Dialing Information 
To make an emergency call: 

  

Enter the international emergency number 112 then  or press  
button. 
 

  
 
1. Your Pocket PC Phone provides international emergency number 112, it 

means the number can normally be used to make an emergency call in any 
country, with/ without a SIM card inserted, if a mobile phone service 
networks within. 

 
2. Some mobile phone service providers may require that a SIM card is 

inserted, and in some cases that the PIN has been entered as well. 
 
3. In some cases, other emergency numbers may also be promoted. Your mobile 

phone service provider may save additional local emergency numbers in the 
SIM card. 

    65



To make an international call: 

 

 
1. Tap and hold the 0 key until the+ sign appears. The + replaces the 

international prefix of the country from where you are calling. 
 
2. Enter the full phone number you want to dial. It includes country code, area 

code (without the leading zero) and phone number. 
 

3. Tap   or press  button. 
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Chapter 5: Getting Connected 
 
You can use your device to exchange information with other mobile devices as well as your PC, a network, or the Internet. You 
have the following connection options: 
 
• Use the infrared (IR) port on your device to send and receive files between two devices. 

• Connect to your mobile Internet service provider (ISP). Once connected, you can send and receive e-mail messages by 
using Inbox and view Web or WAP pages by using Microsoft  Pocket Internet Explorer. The communication software for 
creating a wireless ISP connection is already installed on your device. Your service provider will provide software needed 
to install other services, such as paging and fax services. 

• Connect to the network at your company or organization where you work. Once connected, you can send and receive 
e-mail messages by using Inbox, view Web or WAP pages by using Pocket Internet Explorer, and synchronize with your 
PC. 

• Connect to the virtual private network (VPN) at the company or organization where you work. Once connected, the added 
security of a VPN means that you can access the full resources of your company’s network. For example, you can use File 
Explorer to access the files of computers on that network.  

 

Connect to the Internet 
You can use GPRS to connect to your mobile ISP, and use the connection to send and receive e-mail messages and view Web 
or WAP pages. To connect you must, by activating Operator Configuration, create a cellular or GPRS connection to an ISP, 
and input WAP settings. Auto-configuration stores your operator’s connection settings information. 
 
Operator Configuration 
When you first set up your device, or after performing a full reset, you will need to configure your device for your operator. 
Operator configuration involves loading the GPRS settings, home page details, Today screen “skins”, software and registration 
details specific to your operator.  

To Configure for your operator: 
1. Tap Start, Settings, and then Auto-Configuration. 
 
2. Tap the arrow in the box under I want to do auto-configuration now… , and then choose your operator from the 

drop-down menu. 
 
3. Finally, check the box next to I want to do auto-configuration now… 

To start a connection: 
To start the connection, simply start using one of the following programs. Your device will automatically begin connecting. 
Once connected, you can: 
 
• Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need to provide the information it needs 

to communicate with the e-mail server. For specific instructions, see Connect Directly to an E-mail Server later in this 
chapter. 

• Visit Web and WAP pages by using Pocket Internet Explorer. 

• Send and receive instant messages with MSN Messenger. 

 A pop-up screen will appear once you begin connecting, and leave when the 
connection is complete. 
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Connect Directly to an E-mail Server 
You can set up a connection to an e-mail server so that you can send and receive e-mail messages by using a modem or 
network connection and Inbox on your device. 
 

 The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP gateway. 

You can use multiple e-mail services to receive your messages. For each e-mail service you intend to use, first set up and name 
the e-mail service. If you use the same service to connect to different mailboxes, set up and name each mailbox connection. 

To set up an e-mail service: 
  

1. In Inbox on 
your device, 
tap Services, 
and then New 
Service. 
Follow the 
directions in 
the New 
Service 
wizard. 

  
2. To fill you e-mail 

address in the field, 
and then tap Next. 

 
 

Next will initiate 
auto-configuration – 
which attempts to 
connect your Pocket 
PC Phone to your 
email server and 
automatically 
download the 
necessary email 
connection settings.  

 
If auto-configuration is 
successful you can 
begin sending/ 
receiving emails 
straight away. 
 
If unsuccessful you 
will need to enter the 
settings manually (see 
screens 4/5 & 5/5) .     
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3. Enter “Your 

name”, your 
“User name” 
and 
“Password” 
then tap Next.

  
 
4. From the drop down 

menu select the 
“Service type” that 
your email provider 
supports (POP3 or 
IMAP4). 

 
5. Enter a “Name” for 

your email account 
then tap Next. 

 
 
 
 

 

 
6. Enter the your email provider’s server name information for Incoming mail and 

Outgoing mail, then tap Finish.For an explanation of a screen, tap  and 
then Help. When finished, to connect to your e-mail server, tap Services and 
then Connect. 

 

Get Help on Connecting 
More information on creating a connection to work or the Internet, as well as information on additional procedures, can be 
found in the following locations: 
 
• The accompanying Settings Guide. 

• Inbox: Sending and Receiving E-mail Messages or short messages in Chapter 6. 

• Online Help on the device. Tap  and then Help. Tap View, All Installed Help, and then Inbox or Connections. 
 
• ActiveSync Help on the desktop computer. In ActiveSync, click Microsoft ActiveSync Help on the Help menu. 
For troubleshooting information, see the Pocket PC Web site at: http://www.microsoft.com/mobile/pocketpc 
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Chapter 6: Wireless Data Programs 
 
As well as wireless voice communication your device has built in support for a range of wireless data communication forms. 
You can: 

1. Browse the Web and view WAP-enabled sites 

2. Send SMS 

3. Send and receive email 

4. Synchronize with your PC remotely 

5. Send and receive information from another IR-compatible Windows-powered device  

Except in the case of No.5, in order to use these features the following steps must have been completed: 

1. Your mobile phone service provider supports data transmission (for further information contact your mobile phone 
service provider).  

2. You have an account for Web and email access with an ISP or at a network through your company or another 
organization. (It may be that your mobile phone service provider is acting as your ISP) 

3. You have set up a dial up connection to an ISP or network on your Pocket PC Phone.  

4. Your wireless connection to your mobile service provider is turned on but you are not using it. 

5. You have switched on one of the dial up networking connections established in 4 above.  

 Pocket Internet Explorer: Browsing Web and WAP pages 
 
Use Microsoft  Pocket Internet Explorer to view Web HTML, cHTML and WAP pages. You can browse in either of these 
ways: 

• During synchronization with your PC, download your favorite links and mobile favorites that are stored in the Mobile 
Favorites folder in Internet Explorer on the PC. 

• Connect to an Internet service provider (ISP) or network and browse the Web. To do this, you’ll need to create the 
connection first, as described in the separate Settings Guide. 

When connected to an ISP or network, you can also download files and programs from the Internet or intranet. 
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Using Pocket Internet Explorer 

 

To switch to Pocket Internet Explorer: 
• Tap  and then Internet Explorer. 

You can use Pocket Internet Explorer to browse mobile 
favorites and channels that have been downloaded to your 
device without connecting to the Internet. You can also connect 
to the Internet through an ISP or a network connection and 
browse the Web/ WAP page(s). 

The web page of your operator should appear in 
the blank space n the picture to the left. 

 

To view mobile favorites and channels: 
1. Tap the Favorites button to display your list of 

favorites.  

2. Tap the page you want to view.  

3. You’ll see the page that was downloaded the last 
time you synchronized with your PC. If the page is 
not on your device, the favorite will be dimmed. 
You will need to synchronize with your PC again to 
download the page to your device, or connect to the 
Internet to view the page. 

To browse the Internet: 
1. Set up a connection to your ISP or corporate network using Connections, as described in the separate Settings Guide. 

2. To connect and start browsing, do one of the following: 

• Tap the Favorites button, and then tap the favorite you want to view. 
 
• Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter the Web address you 

want to visit and then tap Go. Tap the arrow to choose from previously entered addresses. 
 

 
 To add a favorite link while using the device, go to the page you want to add, tap 

and hold on the page, and tap Add to Favorites. 
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The Mobile Favorites Folder 
Only items stored in the Mobile Favorites folder in the Favorites folder in Internet Explorer on your PC will be synchronized 
with your device. This folder was created automatically when you installed ActiveSync. 

Favorite Links 
During synchronization, the list of favorite links in the Mobile Favorites folder on your PC is synchronized with Pocket 
Internet Explorer on your device. Both PC and your device are updated with changes made to either list each time you 
synchronize. Unless you mark the favorite link as a mobile favorite, only the link will be downloaded to your device, and you 
will need to connect to your ISP or network to view the content. For more information on synchronization, see ActiveSync 
Help on the PC. 

Mobile Favorites  
If you are using Microsoft Internet Explorer 5.0 or later on your PC, you can download mobile favorites to your device. 
Synchronizing mobile favorites downloads Web content to your device so that you can view pages while you are disconnected 
from your ISP and PC. 

Use the Internet Explorer plug in installed with ActiveSync to create mobile favorites quickly. 

To create a mobile favorite: 
1. In Internet Explorer on your desktop computer, click Tools and then Create Mobile Favorite. 

2. To change the link name, enter a new name in the Name box.  

3. Optionally, in Update, select a desired update schedule. 

4. Click OK. Internet Explorer downloads the latest version of the page to your desktop computer. 

5. Limit the number of downloaded linked pages. In Internet Explorer on the desktop computer, click Favorites; then move 
your mouse through Mobile Favorites to the mobile favorite you want to change. Finally, right-click the mobile favorite 
and then Properties; in the Download tab, specify 0 or 1 for the number of linked pages you want to download. 

 
6. Synchronize your device and desktop computer. Mobile favorites that are stored in the Mobile Favorites folder in Internet 

Explorer are downloaded to your device. 

 
If you did not specify an update schedule in step 3, you will need to manually download content 
to keep the information updated on your desktop computer and device. Before synchronizing 
with your device, in Internet Explorer on your desktop computer, click Tools and then 
Synchronize. You will see the last time content was downloaded to the desktop computer, and 
you can manually download content if needed. 

 You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet 
Explorer on your desktop computer, click View, Toolbars, and then Customize. 

Saving Device Memory 
Mobile favorites take up storage memory on your device. To minimize the amount of memory used: 

• In ActiveSync on your desktop, click Options, select Favorites/Internet Explorer, tap Settings and then Customize. 
You can then deselect Synchronize Images, Synchronize Sound and/or Synchronize offline content pages, to stop 
pictures and sounds, or some mobile favorites from being downloaded to the device. For more information, see 
ActiveSync Help. 

• Limit the number of downloaded linked pages. In Internet Explorer on the desktop computer, click Favorites; then move 
your mouse through Mobile Favorites to the mobile favorite you want to change. Finally, right-click the mobile favorite 
and then Properties. In the Download tab, specify 0 or 1 for the number of linked pages you want to download. 
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To browse the Internet: 
1. Set up a connection to your ISP or corporate network using Connections, as described in the separate Settings Guide. 

2. To connect and start browsing, do one of the following: 

• Tap the Favorites button, and then tap the favorite you want to view. 
 
• Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter the Web address you 

want to visit and then tap Go. Tap the arrow to choose from previously entered addresses. 
 

 To add a favorite link while using the device, go to the page you want to add, 
tap and hold on the page, and tap Add to Favorites. 

 

Using AvantGo Channels 
AvantGo is a free interactive service that gives you access to personalized content and thousands of popular Web sites. You 
subscribe to AvantGo channels directly from your device. Then, you synchronize your device and PC, or connect to the 
Internet to download the content. For more information, visit the AvantGo Web site. 

To sign up for AvantGo: 
1. In ActiveSync options on the desktop computer, turn on synchronization for the AvantGo information type. 
2. In Pocket Internet Explorer on your device, tap the Favorites button to display your list of favorites. 

3. Tap the AvantGo Channels link. 

4. Follow the directions on the screen. You will need to synchronize your device with your desktop computer and then tap 
the My Channels button to complete the AvantGo setup. 

When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a few of the most popular 
channels. To add or remove channels, tap the Add or Remove link. 
 

 MSN Messenger: Instant Messaging 
MSN  Messenger on your mobile device is an instant messaging program that lets you: 
 
• See who is online. 
 
• Send and receive instant messages. 

• Have instant message conversations with groups of contacts. 

To use MSN Messenger, you must have a Microsoft Passport™ account or a Microsoft Exchange e-mail account. You must 
have a Passport to use MSN Messenger Service. If you have a Hotmail  or MSN account, you already have a Passport. Once 
you have obtained either a Microsoft Passport or a Microsoft Exchange account, you are ready to set up your account. 
 

 Sign up for a Microsoft Passport account at http://www.passport.com. Get 
a free Microsoft Hotmail e-mail address at http://www.hotmail.com. 

 

To switch to MSN Messenger: 
Tap , Programs, and then tap MSN Messenger. 
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Setting Up  
Before you can connect, you must enter Passport or Exchange account information. 

 
To set up an account and sign in: 
1. In the Tools menu, tap Options. 
2. In the Accounts tab, enter your Passport or Exchange account information. 
3. To sign in, tap the sign in screen and enter your e-mail address and 

password. 
To change from your Exchange account to your Passport account, and sign 
in 

4. In the Tools menu, tap Options. 
5. In the Accounts tab, tick Enable Passport account, enter your Passport 

account information, under Sign in using this account first tick Passport 
account, and then tap OK. 

6. To sign in, tap the sign-in screen and enter your e-mail address and 
password. 

 If you already use MSN Messenger on your PC, your contacts will show up on your device 
without being added again. 

 
Working with Contacts 

  
• The MSN Messenger window shows all of your 

messenger contacts at a glance, divided into Online 
and Not Online categories. From this view, while 
connected, you can chat, send e-mail, block the 
contact from chatting with you, or delete contacts 
from your list using the pop up menu. 

 To see others online without being seen, in the Tools menu, tap My Status and select Appear 
Offline. If you block a contact, you will appear offline but will remain on the blocked contact’s 
list. To unblock a contact, tap and hold the contact, then tap Unblock on the pop up menu. 
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Chatting with Contacts 
  

• Tap a contact name to open a chat window. Enter your 
message in the text entry area at the bottom of the 
screen, or tap My Text to enter a preset message, and 
tap Send. To invite another contact to a multi user 
chat, in the Tools menu, tap Invite and tap the contact 
you want to invite. 

 

 To switch back to the main window without closing a chat, tap the Contacts button. To revert 
back to your chat window, tap Chats and select the person whom you were chatting with. 

 
  

• To know if the contact you are chatting with is 
responding, look for the message under the text entry 
area. 

• For more information on using MSN Messenger, tap 

 and then Help. 
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 Inbox: Sending and Receiving E-mail or SMS 
Use Inbox to send and receive e-mail messages in either of these ways:  
 
• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your PC. 
• Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or 

a network. 

You also can use Inbox to send and receive SMS; it supports 8 bits data with class 0, 1, 2, 3. And Unstructured Supplementary 
Service Data (USSD) as well. 
 
Synchronizing E-mail Messages 
E-mail messages can be synchronized as part of the general synchronization process. You will need to enable Inbox 
synchronization in ActiveSync. For information on enabling Inbox synchronization, see ActiveSync Help on the PC. 
 
During synchronization: 
 
• Messages are copied from the mail folders of Exchange or Outlook on your PC to the ActiveSync folder in Inbox on your 

device. By default, you will receive messages from the past five days only, the first 100 lines of each message. 
 
• E-mail messages in the Outbox folder on your device are transferred to Exchange or Outlook, and then sent from those 

programs. 
• E-mail messages in folders must be selected in ActiveSync on your PC in order to be transferred. 
 
Connecting Directly to an E-mail Server 
In addition to synchronizing e-mail messages with your PC, you can send and receive e-mail messages by connecting to an 
e-mail server using a modem or network card connected to your device. You’ll need to set up a remote connection to a network 
or an ISP, and a connection to your e-mail server.  
 
When you connect to the e-mail server, new messages are downloaded to the device Inbox folder, messages in the device 
Outbox folder are sent, and messages that have been deleted on the e-mail server are removed from the device Inbox folder. 
Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your PC. When you delete 
a message on your device, it is also deleted from the e-mail server the next time you connect based on the settings you selected 
in ActiveSync. 
 
You can work online or offline. When working online, you read and respond to messages while connected to the e-mail server. 
Messages are sent as soon as you tap Send, which saves space on your device. 
When working offline, once you’ve downloaded new message headers or partial messages, you can disconnect from the e-mail 
server and then decide which messages to download completely. The next time you connect, Inbox downloads the complete 
messages you’ve marked for retrieval and sends the messages you’ve composed. 
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Using the Message List 
  

 
 
• Messages you receive are displayed in the message 

list. By default, the most recently received messages 
are displayed first in the list. 

 

  
• When you receive a message, tap it to open it. Unread 

messages are displayed in bold. 
 

 
When you connect to your e-mail server or synchronize with your PC, by default, you’ll receive messages from the last five 
days only, the first 100 lines of each new message. The original messages remain on the e-mail server or your PC.  
 
You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server connection. In 
the message list, tap and hold the message you want to retrieve. On the pop up menu, tap Mark for Download. The icons in 
the Inbox message list give you visual indication      of message status. 
 
You specify your downloading preferences when you set up the service or select your synchronization options. You can change 
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them at any time: 
 
• Change options for Inbox synchronization using ActiveSync options. For more information, see ActiveSync Help. 
 
• Change options for direct e-mail server connections in Inbox on your device. Tap Tools and then tap Options. On the 

Service tab, tap the service you want to change. Tap and hold the service and select Delete to remove a service. 

Creating an SMS or E-mail 
  

1. Tap New.  

2. In the To field, enter either e-mail address or SMS 
number of one or more recipients, separating them with 
a semicolon, or select a name from the contact list by 
tapping the Address Book button. All e-mail addresses 
entered in the e-mail fields in Contacts appear in the 
Address Book. 

3. Compose your message. To enter preset or frequently 
used messages, tap My Text and select a message. 

4. Tap Send when you’ve finished the message. If you are 
working offline, the message is moved to the Outbox 
folder and will be sent the next time you connect. 

 
 
1. Whether you want to send or read E-mail or a SMS, you 

can swap it by tap Services then choose what service you 
want. 

2. If you are sending an SMS message and want to know if 
it was received, tap Edit, Options, and select Request 
SMS text message delivery notification before sending 
the message. 

 

Managing Messages and Folders 
By default, messages are displayed in one of five folders for each service you have created: Inbox, Deleted Items, Drafts, 
Outbox, and Sent Items. The Deleted Items folder contains messages that have been deleted on the device. The behavior of the 
Deleted and Sent Items folders depends on the options you have chosen. In the message list, tap Tools and then Options. On 
the Message tab, select your options. 
 
If you want to organize messages into additional folders, tap Tools, and then Manage Folders to create new folders. To move a 
message to another folder, in the message list, tap and hold the message and then tap Move to on the pop up menu. 
 
 
Folder behavior with a direct connection to an e-mail server 
The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3, or IMAP4.  
 
1. If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be synchronized with your 

device. You can select to synchronize additional folders by designating them for ActiveSync. The folders you created and 
the messages you moved will then be mirrored on the server. For example, if you move two messages from the Inbox 
folder to a folder named ‘Family’, and you have designated ‘Family’ for synchronization, the server creates a copy of the 
‘Family’ folder and copies the messages into that folder. You can then read the messages while away from your PC. 
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2. If you use SMS, messages are stored in the Inbox folder of SMS category. 
 
3. If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the messages on the 

device and their copies on the mail server. The next time you connect, the mail server will see that the messages are 
missing from the device Inbox and delete them from the server. This prevents you from having duplicate copies of a 
message, but it also means that you will no longer have access to messages that you move to folders created from 
anywhere except the device. 

 
4. If you use IMAP4, the folders you created and the e-mail messages you moved are mirrored on the server. Therefore, 

messages are available to you anytime you connect to your mail server, whether it is from your device or PC. This 
synchronization of folders occurs whenever you connect to your mail server; create new folders, or rename/delete folders 
when connected.  
 

Transferring Items Using Infrared 
Using infrared (IR), you can send and receive information, such as contacts and appointments, between two devices. 

To send information: 
1. Switch to the program where you created the item you want to send and locate the item in the list. 

2. Align the IR ports so that they are unobstructed and within a close range. 

3. Tap and hold the item, and tap Beam Item on the pop up menu. 

 
You can also send items, but not folders, from File Explorer. Tap and hold the item 
you want to send, and then tap Beam File on the pop up menu. 

To receive information: 
1. Align the IR ports so that they are unobstructed and within a close range. 

2. Have the owner of the other device send the information to you. Your device will automatically receive it. 

Terminal Services Client 
Using the Terminal Services Client, you can log onto a Windows NT server type PC that is running Terminal Services 
software and use all of the programs that are available on that PC from your mobile device. For example, instead of running 
Microsoft Pocket Word, you can run the PC version of Microsoft Word and access all of the .doc files on that PC from your 
device. 

 
You cannot use Transcriber when entering information in Terminal Services. 
You must use Keyboard, Block Recognizer, or Letter Recognizer. 

To connect to A Terminal Server: 
Start a remote connection to the server via your wireless modem connection. 
 

1. Tap , Programs, and then Terminal Services Client. 
 
2. To connect to a server you have previously connected to, in Recent Servers, tap a server.  
 
3. To connect to a new server, enter the server’s name in the Server box. Select the limit size of desktop to fit on the 

screen check box only when using applications that have been specifically sized for use with Pocket PC. 
 
4. Tap Connect. 

    79



 
If the network administrator has configured Terminal Services Client to 
reconnect to disconnected sessions, and you previously disconnected from a 
Terminal Server without ending the session, the Terminal Services Client 
reconnects to that session. 

 

To disconnect without ending a session: 
The following commands must be accessed from the Start menu in the Terminal Services window used to access the PC’s 
commands. Do not use the Start menu on your mobile device.  

1. In the Terminal Services Client window, tap , and then Shutdown. 
 
2. Tap Disconnect. 
    

 
If the network administrator has configured Terminal Services Client to reconnect 
to disconnected sessions, you will be reconnected to this session the next time you 
connect to this server. 

To disconnect and end a session: 
1. In the Terminal Services Client window, tap  and then Shutdown. 
 
2. Tap Log Off. 
 

To navigate within Terminal Services Client: 
Once connected to the server, the PC’s screen may more than fill your mobile device’s screen. If scroll bars are displayed on 
the server’s screen, you will see more than one set of scroll bars on your mobile device: 
  

• One to scroll information on the PC, and one to scroll the PC display through the Terminal Services window in 
Terminal Services Client. 

• To ensure you are scrolling the PC display through Terminal Services Client, use the four directional buttons at the 
bottom of the Terminal Services Client screen. 

• To better-fit information on your mobile device’s screen, select Limit size of server desktop to fit on this screen. For 
best effect, programs on the PC should be maximized. 

 

Tips and Tricks 

To improve display performance: 
Display performance is improved by decreasing the time it takes for the screen to be refreshed on the PC. 

1. On your PC, select , Settings and Control Panel. 
2. Click Display. 
3. Clear the Transition effects for menus and tool tips check box. 

To Improve browser performance: 
Performance with Internet Explorer on the PC is improved by decreasing the time it takes for Web pages to be refreshed. 
In Internet Explorer on your PC, select Tools, Internet Options, Advanced, and then clear the Use smooth scrolling check 
box. 
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Chapter 7 : Microsoft ActiveSync 
 
Using Microsoft  ActiveSync , you can synchronize the information on your PC with the information on your device. 
Synchronization compares the data on your device with your PC and updates both with the most recent information. For 
example: 
 
• Keep Pocket Outlook data up-to-date by synchronizing your device with Microsoft Outlook data on your PC.  
• Synchronize Microsoft Word and Microsoft Excel files between your device and PC. Your files are automatically 

converted to the correct format 
 

 
By default, ActiveSync does not automatically synchronize all types of 
information. Use ActiveSync options to turn synchronization on and off for 
specific information types. 

 
With ActiveSync, you can also: 
 
• Back up and restore your device data.  
• Copy (rather than synchronize) files between your device and PC.  
• Control when synchronization occurs by selecting a synchronization mode. For example, you can synchronize continually 

while connected to your PC or only when you choose the synchronize command. 
• Select which information types are synchronized and control how much data is synchronized. For example, you can 

choose how many weeks of past appointments you want synchronized. 
 
After installation is complete, the ActiveSync Setup Wizard helps you to connect your device to your PC, set up a partnership 
so you can synchronize information between your device and your PC, and customize your synchronization settings. Your first 
synchronization process will automatically begin when you finish using the wizard. 
  
After your first synchronization, take a look at Calendar, Contacts, and Tasks on your device. You’ll notice that information 
you’ve stored in Microsoft Outlook on your PC has been copied to your device, and you didn’t have to type a word. Disconnect 
your device from your PC and you’re ready to go! 
 
Once you have set up ActiveSync and completed the first synchronization process, you can initiate synchronization from your 

device. To switch to ActiveSync on your device, tap , and then tap ActiveSync. Note that if you have a wireless LAN card, 
you can synchronize remotely from your device. 
 
For information about using ActiveSync on your PC, start ActiveSync on your PC, and then see ActiveSync Help. 
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• For more information about ActiveSync on your 

device, switch to ActiveSync, tap , and then tap 
Help. 

 

Synchronizing Files 
When you first setup a connection, or by tapping Options in ActiveSync on your desktop, you can see, under Mobile Device, 
the list of programs you can synchronize - this list includes: Calendar, Contacts, Tasks, Inbox, Files, Pocket Access, 
Favorites and AvantGo channels. Files is a folder specially-created on your desktop in My Documents into which you must 
place all files - Word, Excel etc - you wish to synchronize.  

To synchronize files: 
1. Select Files in ActiveSync, and then OK to creating a new folder. 
 
2. Use Windows Explorer on your desktop to find this folder – usually called My Documents pre-fixed by the name you 

gave to your connection – then copy files you want to synchronize into this folder. 

3. Tap Synchronize in ActiveSync. 
 

For more information about ActiveSync on your device, switch to ActiveSync, tap , and then tap Help. 
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Chapter 8: Microsoft Pocket Outlook 
 
Microsoft  Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use these programs individually or 
together. For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Inbox.  
 
Using ActiveSync , you can synchronize information in Microsoft Outlook or Microsoft Exchange on your PC with your 
device. You can also synchronize this information directly with a Microsoft Exchange server. Each time you synchronize, 
ActiveSync compares the changes you made on your device and PC or server and updates both PC with the latest information.  
For information on using ActiveSync, see ActiveSync Help on the PC. 

You can switch to any of these programs by tapping them on the  menu. 

 Calendar: Scheduling Appointments and Meetings 
 
 

 
• Use Calendar to schedule appointments, including 

meetings and other events. You can check your 
appointments in one of several views (Agenda, 
Day, Week, Month, and Year) and easily switch 
views by using the View menu. 

 
 

 
You can customize the Calendar display, such as changing the first day of the week, by 
tapping Options on the Tools menu. 
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To create an appointment: 
 

 

 

1.  If you are in Day or Week view, tap the desired date and 
time for the appointment. 

2. Tap New.  

3. Using the input panel, enter a description and a location. 
Tap first to select the field.  

4. If needed, tap the date and time to change them. 

5. Enter other desired information. You will need to hide the 
input panel to see all available fields. 

6. To add notes, tap the Notes tab. You can enter text, draw, 
or create a recording. For more information on creating 
notes, see Notes: Capturing Thoughts and Ideas later in 
this chapter. 

7. When finished, tap OK to return to the calendar.  

 If you select Remind me in an appointment, your device will remind you according to the 

options set in , Settings, Personal tab, Sounds & Reminders. 

Using the Summary Screen 
  

• When you tap an appointment in Calendar, a summary 
screen is displayed. To change the appointment, tap Edit. 

 

Creating Meeting Requests 
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request will be created 
automatically and sent either when you synchronize Inbox or when you connect to your e-mail server. Indicate how you want 
meeting requests sent by tapping Tools and then Options. If you send and receive e-mail messages through ActiveSync, select 
ActiveSync. 
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To schedule a meeting: 
  

1. Create an appointment. 

2. In the appointment details, hide the input panel, and then 
tap Attendees. 

3. From the list of e-mail addresses you’ve entered in 
Contacts, select the meeting attendees.  

4. The meeting notice is created automatically and placed in 
the Outbox folder. 

 
For more information on sending and receiving meeting 
requests, see Calendar Help and Inbox Help on the device. 

 Contacts: Tracking Friends and Colleagues 
 

  
• Contacts maintains a list of your friends and 

colleagues so that you can easily find the 
information you’re looking for, whether you’re 
at home or on the road. Using the device infrared 
(IR) port, you can quickly share Contacts 
information with other device users. 

 

 
 

To change the way information is displayed in the list, tap Tools and then Options. 
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To create a contact: 

 

1. Tap New. 

2. Using the input panel, enter a name and other contact 
information. You will need to scroll down to see all 
available fields. 

3. To assign the contact to a category, scroll to and tap 
Categories and select a category from the list. In the 
contact list, you can display contacts by category. 

4. To add notes, tap the Notes tab. You can enter text, 
draw, or create a recording. For more information on 
creating notes, see Notes: Capturing Thoughts and 
Ideas later in this chapter. 

5. When finished, tap OK to return to the contact list. 

To Find a contact: 

 

There are 6 ways to find a contact: 
1. Press and hold the upside of the navigation pad until 

alphabetical letters appear on the screen in large type. 
Then use the navigation pad to scroll through the 
alphabet and select a letter. 

 
2. Tap one of the grouping of letters displayed across the 

top of the screen.   
3. In the contact list, enter a contact name in the box 

under the navigation bar. To show all contacts again, 
clear text from the box or tap the button to the right of 
the box.  

4. In the contact list, tap the category list (labeled All 
Contacts by default) and select the type of contact that 
you want displayed. To show all contacts again, select 
All Contacts. To view a contact not assigned to a 
category, select None.  

5. To view the names of companies your contacts work 
for, in the contact list, tap View > By Company. The 
number of contacts that work for that company will be 
displayed to the right of the company name.  

6. Tap , Find, enter the contact name, select 
Contacts for the type, and then tap Go. 
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Using the Summary Screen 
  

• When you tap a contact in the contact list, a summary 
screen is displayed. To change the contact information, 
tap Edit. 

 

 Tasks: Keeping a To Do List 
  

• Use Tasks to keep track of what you have to do.  

 To change the way information is displayed in the list, tap Tools and then Options. 
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To create a task: 
  

1. Tap New. 

2. Using the input panel, enter a description. 

3. You can enter a start date and due date or enter 
other information by first tapping the field. If the 
input panel is open, you will need to hide it to see 
all available fields. 

4. To assign the task to a category, tap Categories and 
select a category from the list. In the task list, you 
can display tasks by category. 

5. To add notes, tap the Notes tab. You can enter text, 
draw, or create a recording. For more information 
on creating notes, see Notes: Capturing Thoughts 
and Ideas later in this chapter. 

6. When finished, tap OK to return to the task list. 

 

 
 

To quickly create a task with only a subject, tap Entry Bar on the Tools menu. 
Then, tap Tap here to add a new task and enter your task information. 

 

Using the Summary Screen 
  

• When you tap a task in the task list, a summary screen 
is displayed. To change the task, tap Edit. 
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 Notes: Capturing Thoughts and Ideas 
 

 
 

 

• Quickly capture thoughts, reminders, ideas, drawings, 
and phone numbers with Notes. You can create a 
written note or a recording. You can also include a 
recording in a note. If a note is open when you create 
the recording, it will be included in the note as an icon. 
If the note list is displayed, it will be created as a 
stand-alone recording. 

 

To create a note: 
  

1. Tap New. 

2. Create your note by writing, drawing, typing, and 
recording. For more information about using the input 
panel, writing and drawing on the screen, and creating 
recordings, see Chapter 3. 
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Chapter 9: Companion Programs 
 
The companion programs consist of Microsoft  Pocket Word, Microsoft  Pocket Excel, Microsoft  Money, and Windows 
Media™ Player for Pocket PC, and Microsoft  Reader.  

To switch to a companion program on your device, tap Programs on the  menu, and then tap the program name. 

 Pocket Word 
 
Pocket Word works with Microsoft Word on your PC to give you easy access to copies of your documents. You can create new 
documents on your device, or you can copy documents from your PC to your device. Synchronize documents between your PC 
and your device so that you have the most up-to-date content in both locations. 

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. To create a new file, tap , 
Programs, Pocket Word, and then New. A blank document appears. Or, if you’ve selected a template for new documents in 
the Options dialog box, that template appears with appropriate text and formatting already provided. You can open only one 
document at a time; when you open a second document, you’ll be asked to save the first. You can save a document you create 
or edit in a variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).  

Pocket Word contains a list of the files stored on your device. Tap a file in the list to open it. To delete, make copies of, and 
send files, tap and hold a file in the list. Then, select the appropriate action on the pop up menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
You can change the zoom magnification by tapping View and then Zoom. Then 
select the percentage you want. Select a higher percentage to enter text and a lower 
one to see more of your document. 
If you’re opening a Word document created on a PC, select Wrap to Window on 
the View menu so that you can see the entire document. 
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You can enter information in Pocket Word in one of four modes (typing, writing, drawing, and recording), which are displayed 
on the View menu. Each mode has its own toolbar, which you can show and hide by tapping the Show/Hide Toolbar button on 
the command bar. 
 
Typing Mode 

  
• Using the input panel, enter typed text into the 

document. For more information on entering 
typed text, see Chapter 3. 

• To format existing text and to edit text, first 
select the text. You can select text as you do in a 
MS-Word document, using your stylus instead of 
the mouse to drag through the text you want to 
select. You can search a document to find text by 
tapping Edit and then Find/ Replace. 

 

Writing Mode 
  

• In writing mode, use your stylus to write directly 
on the screen. Ruled lines are displayed as a 
guide, and the zoom magnification is greater than 
in typing mode to allow you to write more easily. 
For more information on writing and selecting 
writing, see Chapter 3. 
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If you cross three ruled lines in a single stylus stroke, the writing becomes a 
drawing, and can be edited and manipulated as described in the following 
section.  
Written words are converted to graphics (metafiles) when a Pocket Word 
document is converted to a Word document on your PC. 

Drawing Mode 
  

• In drawing mode, use your stylus to draw 
on the screen. Gridlines appear as a guide. 
When you lift your stylus off the screen 
after the first stroke, you’ll see a drawing 
box indicating the boundaries of the 
drawing. Every subsequent stroke within or 
touching the drawing box becomes part of 
the drawing. For more information on 
drawing and selecting drawings, see 
Chapter 3. 

 

Recording Mode 
In recording mode, embed a recording into your document. Recordings are saved as .wav files. For more information on 
recording, see “Making a Recording” in Chapter 1. 

For more information on using Pocket Word, tap  and then Help. 
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 Pocket Excel 
Pocket Excel works with Microsoft Excel on your PC to give you easy access to copies of your workbooks. You can create 

new workbooks on your device, or you can copy 
workbooks from your PC to your device. Synchronize 
workbooks between your PC and your device so that 
you have the most up-to-date content in both locations. 

Use Pocket Excel to create workbooks, such as expense 

reports and mileage logs. To create a new file, tap , 
Programs, Pocket Excel, and then New. A blank 
workbook appears. Or, if you’ve selected a template for 
new workbooks in the Options dialog box, that 
template appears with appropriate text and formatting 
already provided. You can open only one workbook at 
a time; when you open a second workbook, you’ll be 
asked to save the first. You can save a workbook you 
create or edit in a variety of formats, including Pocket 
Excel (.pxl) and Excel (.xls). 

Pocket Excel contains a list of the files stored on your 
device. Tap a file in the list to open it. To delete, make 
copies of, and send files, tap and hold a file in the list. 
Then select the appropriate action from the pop up 

menu. 
Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and filtering. To display the toolbar, 
tap View and then Toolbar.  
 

 
If your workbook contains sensitive information, you can protect it with a password. To do so, 
open the workbook; tap Edit, and then Password. Every time you open the workbook, you will 
need to enter the password, so choose one that is easy for you to remember but hard for others to 
guess. 

Tips for Working in Pocket Excel 
Note the following when working in large worksheets in Pocket Excel: 
 
• View in full screen mode to see as much of your worksheet as possible. Tap View and then Full Screen. To exit full 

screen mode, tap Restore. 

• Show and hide window elements. Tap View and then tap the elements you want to show or hide. 
 
• Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View and then Freeze Panes. You 

might want to freeze the top and leftmost panes in a worksheet to keep row and column labels visible as you scroll through 
a sheet. 

 
• Split panes to view different areas of a large worksheet. Tap View and then Split. Then drag the split bar to where you 

want it. To remove the split, tap View and then Remove Split. 
 
• Show and hide rows and columns. To hide a hidden row or column, select a cell in the row or column you want to hide. 

Then tap Format, then Row or Column, and then Hide. To show a hidden row or column, tap Tools, then Go To, and then 
type a reference that are in the hidden row or column. Then tap Format, then Row or Column, and then Unhide. 
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 Windows Media Player for Pocket PC 
 
Use Microsoft Windows Media Player for Pocket PC to play digital audio and video files that are stored on your device or on a 

network. To switch to Windows Media Player for Pocket PC, tap , Programs, and then tap Windows Media. 
  

• Use Microsoft Windows Media Player on your PC to 
copy digital audio and video files to your Pocket PC. 
You can play Windows Media and MP3 files on your 
Pocket PC. 

• For more information about using Windows Media 

Player for Pocket PC, tap , and then tap Help. 
 

 Microsoft Reader 
Use Microsoft Reader to read e-Books on your device. Download books to your PC from your favorite e-Book Web site. Then, 
use ActiveSync to copy the book files to your activated device. The books appear in the MS-Reader Library, where you can tap 
them in the list to open them.  
Each book consists of a cover page, an optional table of contents, and the pages of the book. You can: 
 

  

• Page through the book by using the Up/Down control on your device or 
by tapping the page number on each page. 

• Annotate the book with highlighting, bookmarks, notes, and drawings. 
• Search for text and look up definitions for words. 
• The Guide-book contains all the information you'll need to use the 

software. To open the Guide-book, tap Help on the  
• Reader command bar. Or, on a book page, tap and hold on the book title, 

and then tap Help on the pop up menu. 

• To switch to Microsoft Reader, tap , Programs, and then Microsoft 
Reader. 
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Getting Books on Your Device 
You can purchase and download book files from the Web to your PC and then synchronize them with your Pocket PC; however, 
in order to do so, you must have: activated your device – you only need to activate it once -, have an activated copy of MS 
Reader on your PC, and have set up synchronization for Files in ActiveSync. 
 
1. Open ActiveSync on your PC then check you have selected synchronize Files - if you have done so it will appear 

under Information Type; if you have not click Options, Sync options, tick Files and then OK from the pop-up menu. 
(The pop-up menu is telling you our computer will create a folder in which you must put files you wish to 
synchronize) 

2. If you have not already activated your device, open a web browser, go to http://das.Microsoft.com/activate and 
follow the instructions. 

3. Go to www.microsoft.com/reader/shop.asp for a list of retailers selling Microsoft Reader e-Books. 
4. If you do not have a copy of MS-Reader on your PC, go to one of the retailers listed above and download a free copy 

from their site; then activate it as described above. 
5. Go to one of the Microsoft Reader e-Book sites, and follow the instructions in the site for choosing, purchasing and 

downloading a book to your desktop.  
6. Use Windows Explorer on your desktop to locate the MS Reader “My Library” folder and the “Pocket_PC My 

Documents” folder, find the book title in My Library and then copy it to Pocket_PC My Documents.  ActiveSync 
will then download the files from your PC to your activated device. 

 
Sample books and a dictionary are also included in the MS-Reader folder in the Extras folder on the Pocket PC Companion 
CD.  
 
Using the Library 
The Library is your Reader home page; it displays a list of all books stored on your device or storage card. 
 

  

To open the Library: 

• On the Reader command bar, tap Library.  
• On a book page, tap the book title, and then tap 

Library on the pop up menu. 
 
To open a book: 

• Tap its title in the Library list.  
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Reading a Book 
  

Each book consists of a cover page, an optional table 
of contents, and the pages of the book. Navigation 
options are listed in the bottom portion of the cover 
page.  
The first time you open a book, you’ll probably want 
to go to the first page or to the table of contents, if 
there is one.  
Subsequently, whenever you open the book, you’ll be 
automatically taken to the last page read. 
In addition to the text, each book page includes a 
page number and book title.  
You can also page through a book by using the Up/ 
Down control on your device. 

Using Reader Features 
Reading a book electronically gives you several options not available with paper books. These options are available from any 
book page. 
 
Select text by dragging across the text on the page. Then, tap an option on the pop up menu, as described here: 
 
• Search for Text. Find text in a book by tapping Find on the pop up menu. Enter the word you want to search for, and tap 

the desired Find option. Reader highlights found text on the page. To close Find, tap outside the box. To return to your 
original page, tap the title and then tap Return on the pop up menu. 

• Copy Text. You can copy text from books that support this feature into any program that accepts text. On a book page, 
select the text you want to copy. Then, tap Copy Text on the pop up menu. The text can be pasted into the program of your 
choice. 

• Bookmarks. When you add a bookmark to a book, a color-coded bookmark icon appears in the right margin. You can add 
multiple bookmarks to a book. Then, from anywhere in the book, tap the bookmark icon to go to the bookmarked page. 

• Highlights. When you highlight text, it appears with a colored background.  
• Notes. When you attach a note to text, you enter the text in a note pad that appears on top of the book page. A Note icon 

will display in the left margin. To show or hide the note, tap the icon. 

• Drawings. When you add a drawing, a Drawing icon appears in the bottom-left corner of the page, and drawing tools 
appear across the bottom of the page. Draw by dragging your stylus. 

• To see a list of a book’s annotations, including bookmarks, highlights, text notes, and drawings, tap Annotations Index on 
the book’s cover page. You can tap an entry in the list to go to the annotated page. 
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Removing a Book 
  

• When you finish reading a book, you can delete it to conserve 
space on your device. If a copy of the book is stored on your PC, 
you can download it again at any time.  

• To remove a book from your device, tap and hold the title in the 
Library list, and then tap Delete on the pop up menu. 

 

 

Image Viewer 
 

 

 

 
• Image Viewer allows you to conveniently view high-resolution 

JPEG and BMP pictures, whether you are at home or on the road.
• Download images to your PC, and then use ActiveSync to copy 

the files to your Pocket PC Phone. The images appear in Image 
Viewer, where you can tap them in the list to open them 

 
 Pictures can also be stored on a MMC or SD memory 

card to save memory on your device. Insert a card into 
the memory card slot and then copy or drag the 
pictures from your PC to the My Documents directory 
on the memory card (If the memory card does not have 
a My Documents directory you must create one first). 

Image Viewer is based in part on the work of the Independent JPEG group. 
 

Transferring Images to your Pocket PC Phone 
Pictures stored on your PC can be synchronized with Image Viewer on your device. Picture synchronization is not 
automatically selected in ActiveSync. For more information on synchronization, see ActiveSync Help on the PC. 
 
 
Changing your Image List Layout 
You can choose to file your images in a list (see left) or as Viewer icons (see right). 
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• To file images in a list tap View and then Details. 
 
• To file images as Viewers tap View and then Large Icons. 
 
Viewing Images   
1. View any image stored on your device by tapping Start, Programs, Image Viewer and then Browse. 
 
2. In Browse tap Find All or Change Folder – if you tap Change Folder a screen will appear listing the folders on your 

device. 
 
3. Before you choose one you can select to view the actual size of the picture or to fit it to the screen. To do so tap View, 

Zoom, Best Fit or Actual Size. 
 
 
Deleting an Image 
Hold the stylus firmly on the file name of the picture you want to delete, and then select Delete from the pop up menu. 
 
 
Refreshing all Images 
On the pop up menu, tap Refresh, the file information on picture list will be refreshed. 
  
Arranging Order 
If you are working in Details view, you can change the order in which the pictures are listed by tapping any of the following: 
file name, resolution, color numbers, file type, date or file size.  The list will be sorted on the criteria selected. 
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Appendix A: Character Recognizer 
 
Using Character Recognizer, you can write characters directly on your Pocket PC Phone screen with your stylus, just as you 
would on a piece of paper. The characters you write are translated into typed text. Use Character Recognizer anywhere you 
want to enter text, for example, to write a note or to fill in fields in a dialog box.  
 

 
• The default writing mode for Character 

Recognizer is lowercase (Jot-compatible) mode. 
In this mode, you write characters in lowercase. 
The chart at the end of this appendix contains 
examples of how to write characters in 
lowercase mode. You can also choose to write in 
uppercase (Graffiti-compatible) mode. In this 
mode, you write characters in uppercase. If you 
prefer to write in uppercase mode, tap 
Uppercase Mode in Options on the input 
method menu. Whether a letter appears in 
uppercase or lowercase when it is converted to 
typed text depends on where in the input panel 
you write it, not on the mode you have selected.

• The Character Recognizer input panel is divided 
into three writing areas. Letters written in the 
left area (labeled ABC) creates uppercase 
letters, and letters written in the middle area 
(labeled abc) creates lowercase letters. Use the 
right area (labeled 123) for writing numbers, 
symbols, special characters, and punctuation.  

 

 

 
• The chart is a partial display of the characters 

you can write while in lowercase mode (the dot 
on each character is the starting point for 
writing). Remember that even though you write 
a letter in its lowercase form, the case of the text 
that is displayed depends on where you write the 
letter. For example, if you write a lowercase “a” 
in the ABC area, an uppercase “A” is displayed 
on the screen. 

For more information on using Character Recognizer and for demos of all characters, tap  on the Character Recognizer 
input panel.  
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Appendix B: Troubleshooting 
Reset the Pocket PC Phone and Clear Memory  
You can perform a soft reset or a full reset, depending on the situation: a full reset, in the sense that you will lose all data and 
any software you have installed yourself, is similar to reinstalling your OS on your PC; a soft reset is similar to restarting your 
desktop. 
 
If your Pocket PC Phone responds slowly stops responding or freezes, try soft resetting it. A soft reset causes the Pocket PC 
Phone to restart and re-adjust memory allocation. Unsaved data in open windows may be lost. 

To perform a soft reset: 
• Use the stylus to press and hold the Reset button for about two seconds. (For details on finding soft reset, see, “Chapter 2, 

Bottom Edge Features.”) 

To perform a full reset: 
 
Warning:  Clearing memory deletes all data and restores the Pocket PC Phone to its default settings. Programs installed at the 

factory remain, while data you have created and programs you have installed are erased. 
  

  

1. Unscrew the stylus and use the smaller point of the top-half.  

 

 

2. Press the battery switch once to turn it off, and then once more to 
turn it back on. 

 Use ActiveSync to keep a backup of your Pocket PC Phone data so that if you need to clear memory, you 
can restore the data on your Pocket PC Phone. For more information, see ActiveSync Help. 
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Battery loses Power 
When the battery is low, you will see a battery icon (  - main battery low,  - main battery very low) in the status bar of 
the screen and a pop up screen to tell you to recharge the battery as soon as possible. The battery is split into two portions: main 
battery and backup battery. When the main battery portion is discharged your device will power off. However, the backup 
battery portion for 72 hrs will preserve your data. If the backup battery portion is discharged, you run the risk of losing the data 
on your Pocket PC Phone. 
You want your Pocket PC Phone battery charge to last as long as possible, especially when you’re on the road. Under normal 
conditions, you can get many hours of use from a single set of batteries or from a full charge. Here are a few tips to help you 
get the most from them. 

Use external power whenever possible 
Use the AC adapter to plug your Pocket PC Phone into external power whenever possible, especially when: 
• Establishing a remote connection. 

• Using the frontlight feature of your Pocket PC Phone display. 
• Connecting to a PC. 
• Letting the notification light flash for extended periods. 

Shorten auto suspend time 
While on battery power, your Pocket PC Phone automatically suspends operation if you haven’t touched the hardware buttons 

or used the stylus for a specified period. Maximize battery life by shortening the time. Tap and then Settings. On the 
System tab, tap Power, and then adjust the On battery power setting. 
To turn off sounds you don’t need 

The Pocket PC Phone produces sounds in response to a number of events, such as warnings, appointments, and screen taps or 

hardware button presses. To optimize battery life, turn off any sounds you don’t need. Tap  and then Settings. On the 
Personal tab, tap Sounds & Reminders and clear check boxes on the Volume and Reminders tabs. 
To turn off notification light 

Tap  and then Settings. On the Personal tab, tap Sounds & Reminders. On the Reminders tab, clear the Flash light for 
check box. 

If you forget your password 
If you forget your password, you’ll need to clear memory on the Pocket PC Phone. See Reset the device and clear memory 
earlier in this appendix. 

If you run out of Phone memory 
Memory on your Pocket PC Phone is shared between storage memory and program memory. Storage memory is used to store 
the information you create and programs you install. Program memory is used to run programs on your Pocket PC Phone. 
Pocket PC Phone automatically manages the allocation between storage and program memory. However, in some situations, 
such as when memory is low, Pocket PC Phone may not be able to automatically adjust the allocation. If you receive a message 
stating that storage or program memory is unavailable, try the following solutions. 

Finding Space In Storage memory 
• Move data to a MMC/ SD storage card. 

• Tap , Programs, and then File Explorer. Tap and hold the file you want to move, and tap Cut. Browse to the My 
Documents folder in the storage card folder, tap Edit, and then tap Paste. Files stored in folders other than My Documents 
or stored in folders within folders in My Documents may not show up in the list view of some programs. When using 
Notes, Pocket Word, or Pocket Excel, you can also move files by opening the item and tapping Tools or Edit and then 
Rename/Move. 
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• Move e-mail attachments. In Inbox, tap Tools and then Options. On the Storage tab, select Store attachments on 
storage card. All attachments are moved to the storage card, and new attachments are automatically stored on the storage 
card. 

• Set programs such as Notes, Pocket Word, and Pocket Excel to automatically save new items on the storage card. In the 
program, tap Tools and then Options. 

• If you are copying files from your PC or another device to your Pocket PC Phone, try adjusting the slider in the Memory 

setting. Tap  and then Settings. On the System tab, tap Memory and check whether the slider can be adjusted 
manually before copying files. 

• Delete unnecessary files. Tap , Programs, and then File Explorer.  Tap and hold the file, and then tap Delete on the 

pop up menu. To find your larger files, tap  and then Find. In the Type list, tap Larger than 64 KB, and then tap 
Go. 

• In Internet Explorer options, delete all files and clear history. In Internet Explorer, tap Tools and then Options. Tap Delete 
Files and Clear History. 

• Remove programs you no longer use. Tap  and then Settings. On the System tab, tap Remove Programs. Tap the 
program you want to remove and then Remove. 

• Clear program memory as described in the following section. This will free some program memory so that it can be 
allocated to storage memory. 

Finding Space In Program Memory 
• Stop programs you are not currently using. In most cases, programs automatically stop to free needed memory. However, 

in some situations, such as when confirmation dialog boxes are waiting for a user response, the program may not be able to 

automatically stop. To check the state of your active programs, tap  and then Settings. On the System tab, tap 
Memory and then the Running Programs tab. Tap the program you want to view and then tap Activate. Close any open 
windows or messages and return the program to list view. If this doesn’t work, you can stop the program manually. First, 
make sure that closing open items and returning the program to list view save your work. Then, stop the program by 
tapping Stop or Stop All on the Running Programs tab.  

• Clear storage memory as described in the preceding section. This will free some storage memory so that it can be allocated 
to program memory. 

• Reset your Pocket PC Phone can release the program memory, you can do it as described in Reset the Pocket PC Phone 
and clear memory earlier in this appendix. 

Screen freezes or responds slowly 
Reset your Pocket PC Phone. See Reset your Pocket PC Phone and clear memory earlier in this appendix. 

Screen is blank 
If your Pocket PC Phone doesn’t respond when you briefly press the Power button, press and hold the button for a full second. 
If that doesn’t work: 
• Make sure your SIM door cover is closed and all expansion slots are secured. 

• Plug the AC power into device. 
• Reset the device. See Reset the device and clear memory earlier in this appendix. 

Screen is dark 
Prolonged exposure to direct sunlight may cause your Pocket PC Phone screen to temporarily darken. This is normal for LCD 
screens and is not permanent. 
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Screen is hard to read 
If you’re having a hard time viewing a document in Notes, try changing the size of the view. To do this, tap a zoom percentage 
on the Tools menu. In Pocket Word and Pocket Excel, on the View menu, tap Zoom and then select a zoom percentage. In 
Pocket Internet Explorer, on the View menu, tap Text Size and then select a size. 
If you’re having a hard time viewing Pocket Outlook data, try enlarging the display font. To do this within Calendar, Tasks, or 
Contacts, tap Tools, then Options, and then select Use large font. 

Inaccurate response to stylus taps 
Adjust the touch screen to respond more accurately to screen taps. Tap  and then Settings. On the System tab, tap Align 
Screen. Or press and hold Calendar button and then press Action to launch the screen tapping calibration process. 

Slow or no response 
Reset your Pocket PC Phone. See Reset the Pocket PC Phone and clear memory earlier in this appendix. 

Infrared (IR) connection problems 
If you are unable to use IR to transfer information, try the following: 
• Transfer only one file or no more than 25 contact cards at a time. 
• Line up the IR ports so that they are unobstructed and within a close range. 

• Make sure nothing is between the two IR ports.  
• Adjust the room lighting. Some types of light interfere with IR connections. Try moving to a different location or turning 

off some lights. 

Phone connection problems 
If you have a problem using your phone, try the following:  
• Check your wireless connection to your mobile service provider is switched on and the signal unobstructed (For more 

information, see Checking you are Connected).  

• Contact your mobile phone service provider for help. 

Internet connection problems 
The following connection problems may occur. Additional troubleshooting information is available in Connections Help on 
the Pocket PC Phone and ActiveSync Help on the PC. 
• Check you have set up and connected to an Internet service provider. 

• Check your wireless connection to your mobile service provider is switched on and the signal unobstructed (For more 
information, see Chapter 3 “Checking you are Connected”).  

• Check Verify with your Internet service provider that your user name and password are correct. 

• Verify with your Internet service provider that the network you are trying to connect is available, or try to connect to it 
from another PC.  

Network connection problems 
The following connection problems may occur. Additional troubleshooting information is available in Connections Help on 
the Pocket PC Phone and ActiveSync Help on the PC. 
• Check your wireless connection to your mobile service provider is switched on and the signal unobstructed (For more 

information, see Chapter 3 “Checking you are Connected”). 

• Verify that you have added necessary server information. Tap  and then Settings. On the Connections tab, tap 
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Network. Most networks use DHCP, so you should not have to change these settings unless your network administrator 
instructs you to do so. 

• If Network Connection isn't listed as a connection method in the ActiveSync dialog box when starting synchronization, 
wait a few minutes and try again. Also, if synchronization does not start right away, the network is probably busy, and it 
may take a minute for your Pocket PC Phone to connect to the network. 

• Verify with your network administrator that your user name and password are correct. 

• Verify with your network administrator that the network you are trying to connect is available, or try to connect to it from 
another PC.  

 

• You may need to change the device name if you are trying to connect to a network and cannot because another Pocket PC 

Phone with the same name is already connected. To change the Pocket PC Phone name, tap  and then Settings. On 
the System tab, tap About, and then the Device ID tab. 

Cable and cradle connection problems 
The following solutions may help if you encounter problems when connecting to your PC. Additional troubleshooting 
information is available in Connections Help on the Pocket PC Phone and ActiveSync Help on the PC. 
• Ensure the Pocket PC Phone is turned on. 

• Ensure that you do not have any other active connections. Tap  and then Today. Tap  or  at the bottom of 
the screen and then Disconnect. 

• Ensure the cable is securely plugged into the COM port on the back of your PC. Use the cable that came with the Pocket 
PC Phone without any extra cables or extenders attached. 

• Plug the other end of the cable securely into the correct port on your Pocket PC Phone. If you are using a cradle, push your 
Pocket PC Phone securely into the cradle. 
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Appendix C: Regulatory Notices 
Regulatory Agency Identification Numbers 
For regulatory identification purposes your product is assigned a model number PW10xx. 
The following accessories have been evaluated for use with your device. Their assigned model numbers listed below can 
identify these approved accessories. To ensure continued reliable and safe operation of your Pocket PC Phone, use only 
the accessories listed below with your PW10xx. 

 

Accessories Model Number 

Pocket PC Phone PW10xx 

Cradle PW15x 

External Battery Pack PW16x 
 

Note 1: The above “x” may be any alphanumeric character or blank denoting external cosmetic changes. 

Note 2: This product is intended for use with certified Class 2, rated 5 V dc, minimum 1A power supply unit. 

European Union Notice 
Products with CE marking comply with the R&TTE Directive (99/5/EC), the EMC Directive (89/336/EEC) and the Low 
Voltage Directive (73/23/EEC) issued by the Commission of the European Community. 

Compliance with these directives implies conformity to the following European Norms (in brackets are the equivalent 
international standards):  

 EN 60950 (IEC 60950) - Safety of Information Technology Equipment 

 ETS 300 342-1 (June 1997) - Electromagnetic compatibility and Radio spectrum Matters (ERM); 
ElectroMagnetic Compatibility (EMC) for European digital cellular telecommunications system (GSM 900MHz 
and GSM 1900MHz); Part 1: Mobile and portable radio and ancillary equipment 

 GSM11.10 

 ANSI/IEEE C.95.1-1992- specific absorption rate in mobile phone emission condition for body health  

 FCC part 15 and part24 

 prENV50166-2, 1995 for SAR 

 SAR: 0.892mW/10g  
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Important Safety Information 
Retain and follow all product safety and operating instructions. Observe all warnings on the product and in the operating 
instructions. 
To reduce the risk of bodily injury, electric shock, fire, and damage to the equipment observe the following 
precautions. 

General Precautions 
Heed service markings: Except as explained elsewhere in the Operating or Service documentation, do not service any 
product yourself. Service needed on components inside these compartments should be done by an authorized service 
technicians or provider. 
 
Damage requiring service: Unplug the product from the electrical outlet and refer servicing to an authorized service 
technicians or provider under the following conditions: 
 
z Liquid has been spilled or an object has fallen into the product. 
z The product has been exposed to rain or water. 
z The product has been dropped or damaged. 
z There are noticeable signs of overheating. 
z The product does not operate normally when you follow the operating instructions. 
 
Avoid hot areas: The product should be placed away from heat sources such as radiators, heat registers, stoves, or other 
products (including amplifiers) that produce heat. 
Avoid wet areas: Never use the product in a wet location. 
Avoid pushing objects into product: Never push objects of any kind into cabinet slots or other openings in the product. 
Slots and openings are provided for ventilation. These openings must not be blocked or covered. 
Mounting Accessories: Do not use the product on an unstable table, cart, stand, tripod, or bracket. Any mounting of the 
product should follow the manufacturer’s instructions, and should use a mounting accessory recommended by the 
manufacturer. 
Avoid unstable mounting: Do not place the product with an unstable base.  
Use product with approved equipment: This product should be used only with personal computers and options identified 
as suitable for use with your equipment. 
Adjust the volume: Turn down the volume before using headphones or other audio devices. 
Cleaning:  Unplug the product from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a 
damp cloth for cleaning, but NEVER use water to clean an LCD screen. 

Safety Precautions for Power Supply Unit 
 
Use the correct external power source: A product should be operated only from the type of power source indicated on the 
electrical ratings label. If you are not sure of the type of power source required, consult your authorized service provider or 
local power company. For a product that operates from battery power or other sources, refer to the operating instructions 
that are included with the productHandle battery packs carefully: This product contains a Lithium Polymer battery. 
There is a risk of fire and burns if the battery pack is handled improperly. Do not attempt to open or service the battery pack. 
Do not disassemble, crush, puncture, short external contacts or circuits, dispose of in fire or water, or expose a battery pack 
to temperatures higher than 60°C (140°F). 
 

 
DANGER OF EXPLOSION IF BATTERY IS INCORRECTLY REPLACED. 
REPLACE ONLY WITH SPECIFIED BATTERIES. DISPOSE OF USED 
BATTERIES ACCORDING TO THE LOCAL REGULATIONS OR 
REFERENCE GUIDE SUPPLIED WITH YOUR PRODUCT. 
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Appendix D: Hardware Specifications 
Feature Component 
PDA module: Processor 
                       
Memory 

Intel SA-1110 CPU 
SDRAM 32MB; Flash ROM: 32MB  

GSM/GPRS module 900/1800 MHz. 
LCD module 3.5” 240x320 pixels, 4096 colors reflection TFT. 

Buttons Four buttons (2 GSM and 2 Windows CE AP buttons - programmable); 
power and back light control; navigation pad for scroll up, down, left, right 
and action; volume adjustment button.   

Stylus 101 mm, maximum diameter 4.5 mm 
Notification One LED or Vibration motor for GSM and PDA for event/standby alarm, 

charging. 
Audio Built in Microphone and speaker; one earphone/ microphone jack with 

stereo sound; MP3 stereo 
Interface Plug in SIM card; feature connector (RS-232, USB and DC power); 

infrared IrDA SIR. 
Power Rechargeable battery Li-Polymer; 3.7V 1500 mAh; built in charger.  
Accessories AC adapter (input: 100-240Vac, 50-60Hz, 0.2A; output: 5VDC, 1A Max, 

5W) 
USB cradle; earphone plug; service kit; protective pouch.  
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Appendix E: Icons 
Phone 

 
Phone off or out of network service, tap to turn on the phone. 

 Phone on or in network service, tap to turn off the phone. 

 
Shows your connection is at full strength. 

 
Call Missed, tap to view  call(s) you missed.,  

 
E-mail or SMS notification, tap to view  SMS or E-mails not read. 

 
Synchronization proceeding, the icon will disappear  when synchronization has finished. 

 
Send button, press to  make a phone call. 

 
End button, press to end a call. 

 
Talk, tap to make a phone call in phone dialer. 

 Clear, tap to erase the number you inputted in phone dialer. 

 
End, tap to end a call in phone dialer. 

 
Erase, tap to erase  numbers you inputted one by one. Or tap and hold the icon to erase the whole number you 

input in phone dialer. 

 
Notes, tap during a call to make a note for that particular call in phone dialer. 

 
Speed Dial, tap to view the speed dial list.  

 
Call Log, tap to view call details.. 

 
Incoming call, notifys you of an incoming call. 

 
Outgoing call, notifys you of an outgoing call. 

 
Missed call, notifys you of a call you missed. 
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Pocket PC 
 

Start menu, tap to pull down the start menu. 

 
System volume, tap to adjust the volume both for phone and Pocket PC.  

 
Power low, notifies you the battery is in the power low status. 

 
Power very low, recharge the device to avoid the data lost. 

 
Connection is active; the icon will  disappear when your device is connectedend. 

 
Synchronization proceeding, the icon will  disappear when synchronization is complete. 

 
Instant message notification, tap to read the content of instant message. 

 
E-mail or SMS notification, tap to view SMS or E-mail not read. 

 
Establishing the connection, the icon will be disappear when the connection is established. 

 
Icon room, If more notification icons need to be displayed than there is room to display them. Tap the icon to view 

all notification icons.  

 
ActiveSync, synchronizing information between your device and PC. 

 
Calendar, keeptrack of your appointments and create meeting requests. 

 
Contacts, keeptrack of your friends and colleagues. 

 
Inbox, send and receive e-mail/ SMS messages. 

 
Pocket Internet Explorer, browsing Web and WAP sites, and download new programs and files from the Internet.

 
Notes, create handwritten or typed notes, drawings, and recordings. 

  
MS-Reader, read E-books on your device. 

 
Image Viewer, view JPG and GIF format pictures on your device. 

 
Tasks, keep track of your tasks. 

 
Pocket Excel, create new workbooks or view and edit Excel workbooks. 

 
Pocket Word, create new documents or view and edit MS-Word documents.  

 
MSN Messenger, send and receive instant messages with your MSN Messenger contacts. 

 
Phone, make and receive calls, swap between calls and set up conference calling.  

 

SD Backup, backup your Pocket PC Phone files to an SD card. 
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SIM Manager, loads contents of your SIM card to your device and allows you to transfer to Contacts. 

 
Windows Media Player, enables the multimedia function on your Pocket PC Phone. 

 

Buttons, assigns the application program to hardware button. 

 
Input, setup the input portion of your device. 

 
Menu, customizing what appears on the  menu, and to enable a pop up menu from the New button. 

 
Owner Information, entering your contact information. 

 
Password, limiting access to your device. 

 
Phone; setup the phone function of your wireless feature. 

 

Sound and notification, sets the notification type, event, and volume. 

 
Today, customize the look and  information that is displayed on the Today screen. 

 
Backlight, customize the backlight, and adjust the brightness.  

 
Clock, change the time or  set the alarm. 

 

Microphone AGC, enable/ disable the microphone AGC. 

 

Power, maximize battery life. 

 
Regional settings, customize the region and relative format for the region you use. 

 
Remove programs, you may through this function to remove some application program(s) not used 
frequently. 

 

Screen, re-calibrate the screen by tapping.. 

 
Infrared, use universal beaming to send contacts to a range of infrared equipped handheld devices.  
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